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How to use this Competency Based Learning Materials (CBLMs) 
  

The module, Separate and Compose Images contains training materials and activities for 

you to complete. These activities may be completed as part of structured classroom 

activities or you may be required you to work at your own pace. These activities will ask 

you to complete associated learning and practice activities in order to gain knowledge and 

skills you need to achieve the learning outcomes.  

1. Review the Learning Activity page to understand the sequence of learning 

activities you will undergo. This page will serve as your road map towards the 

achievement of competence.  

  

2. Read the Information Sheets. This will give you an understanding of the jobs or 

tasks you are going to learn how to do. Once you have finished reading the 

Information Sheets complete the questions in the Self-Check.  

  

3. Self-Checks are found after each Information Sheet.  Self-Checks are designed to 

help you know how you are progressing.  If you are unable to answer the questions 

in the Self-Check you will need to re-read the relevant Information Sheet. Once 

you have completed all the questions check your answers by reading the relevant 

Answer Keys found at the end of this module.  

  

4. Next move on to the Job Sheets. Job Sheets provide detailed information about 

how to do the job you are being trained in. Some Job Sheets will also have a series 

of Activity Sheets. These sheets have been designed to introduce you to the job 

step by step. This is where you will apply the new knowledge you gained by reading 

the Information Sheets. This is your opportunity to practise the job. You may need 

to practise the job or activity several times before you become competent.  

   

5. Specification sheets, specifying the details of the job to be performed will be 

provided where appropriate.  

  

6. A review of competency is provided on the last page to help remind if all the 

required assessment criteria have been met. This record is for your own information 

and guidance and is not an official record of competency  

  

When working though this Module always be aware of your safety and the safety of 

others in the training room. Should you require assistance or clarification please consult 

your trainer or facilitator.  

  

When you have satisfactorily completed all the Jobs and/or Activities outlined in this 

module, an assessment event will be scheduled to assess if you have achieved 

competency in the specified learning outcomes. You will then be ready to move onto 

the next Unit of Competency or Module  
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Module Content 

 

Unit of Competency: Separate and Compose Images 

Module Title: Separating and Compose Images  

Module Description: This module covers the knowledge, skills and attitudes required to 

separate and compose images. It specifically includes separating 

images, creating a composition, retouching image, applying color 

correction, applying effects, and evaluating own work.    

Nominal Duration: 60 Hours  

Learning Outcomes:  

Upon completion of this module the trainees must be able to:  

1. Separate Images  

2. Create a composition  

3. Retouch Image 

4. Apply color Correction 

5. Apply Effects 

6. Evaluate own work  

 

Assessment Criteria: 

1.1. Image is selected 

1.2. Required tool is selected 

1.3. Clipping path is created 

1.4. Image is separated from background 

2.1 New document is created 

2.2 Images are pasted for edit 

2.3 Layers are created and selected. 

2.4 Images are edited and arranged. 

3.1 Appropriate retouch tools are identified 

3.2 Tools are calibrated as required 

3.3 Layers are created and preserved 

3.4 Retouch tools are used as per requirement 

3.5 Images are corrected and saved in appropriate file format 

4.1 Color correction methods are identified 

4.2 Appropriate image mode is selected 

4.3 Color correction methods are used 

4.4 Image enhancement is compared with the original one 

4.5 Design is saved in appropriate file format 

4.6 Final image is transferred to recipient 

5.1 Identify appropriate effect options 
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5.2 Proper image mode is selected 

5.3 Effects are applied to images/ layer as per requirements 

5.4 Effects are compared and adjusted 

5.5 Image is saved in appropriate file format 

5.6 Image is transferred to recipient 

6.1 Constructive criticism from others is applied to improve own works. 

6.2 Own works are evaluated against planned Strategy for own practice. 

Contents  

This learning package includes the following:  

1. Images separation  

2. Composition creation 

3. Image retouching 

4. Color correction 

5. Effects 

6. Own work evaluation 
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Learning Outcome 1: Separate Images 

 

Content: 

1. Image separation tools 

a. Magic wand tool 

b. Lasso tool 

c. Pen tool 

2. Clipping path  

Assessment Criteria:  

4. Image is separated from background 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 

 Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
  

1. Image is selected 

2. Required tool is selected 

3. Clipping path is created 
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Learning Experience 1: Separate Images 

 

In order to achieve the objectives stated in this learning guide, you must perform the learning 

steps below. Beside each step are the resources or special instructions you will use to 

accomplish the corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about Develop 

Competency Based 

Training Curriculum. 

1. Instructor will provide the learning materials 

“Separate and Compose Images 

2. Read the Information 

sheet/s 

2. Information Sheet No:1 Interpret fundamentals of 

graphic design 

3. Complete the Self 

Checks & Check answer 

sheets. 

3. Self-Check/s 

Self-Check No: 1 Interpret fundamentals of graphic 

design 

Answer key No. 1 Interpret fundamentals of graphic 

design 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:1- Interpret fundamentals of graphic 

design 

Specification Sheet1 – Interpret fundamentals of 

graphic design 
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Information Sheet 1: Separate Images 

 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Image is selected 

2. Required tool is selected 

3. Clipping path is created 

4. Image is separated from background 
1. Image 

An image is a visual representation or depiction of something, typically created or captured 

through various methods, such as photography, digital art, painting, or graphics. It is a 

two-dimensional representation that can be viewed or perceived by the human eye or by 

electronic devices. 

In Adobe Photoshop, there are several tools and techniques you can use to separate or 

isolate elements within an image. Here are some commonly used tools for image 

separation: 

Magic Wand Tool: The Magic Wand Tool allows you to select areas of similar color or 

tone in an image. By clicking on a specific area, the tool selects contiguous pixels with 

similar attributes, making it useful for selecting and separating specific regions of an 

image. 

Quick Selection Tool: The Quick Selection Tool helps you make quick selections based 

on the edges and contrast in an image. You can brush over the desired areas, and the tool 

automatically detects and selects similar regions. This tool is particularly effective for 

separating objects with well-defined edges. 

Pen Tool: The Pen Tool is a versatile tool that allows you to create precise paths and 

selections by placing anchor points and adjusting curve handles. You can manually trace 

the contours of an object to create a path, which can be used for separation or to create 

complex selections. 

Lasso Tool: The Lasso Tool enables you to manually draw selections around specific areas 

of an image. It offers different variations, including the standard Lasso Tool, Polygonal 

Lasso Tool, and Magnetic Lasso Tool. The Polygonal Lasso Tool allows you to draw 

straight-sided selections, while the Magnetic Lasso Tool snaps to the edges of objects for 

more accurate selections. 

a. The Magic Wand Tool 

Remove A Background with The Magic Wand Tool in Photoshop 

When making complex selections, you can alter the settings to correctly select the 

background. You can also use the Select and Mask workspace to touch up your 

selection, and achieve the best results possible. For this example, the background has 

more color tones, but there are also complex edges around the feathers to deal with. 
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To select the background, select the magic wand tool in the toolbar. 

 

 

 

Then, go up to the Options bar to adjust a few 

settings. In case you have different hues in your 

image, it is a good idea to increase the Sample 

Size so that you can add more pixels as the basis 

for your selection. 

 

In my case, I increased the sample size to 5×5 because my background has green, 

brown, and even gray tones. 

 

You can set tolerance to 32, which is the default tolerance value. You can change this 

value later if you need to. 
 

 
 

You should always leave Contiguous and Anti-alias checked when removing 

backgrounds. Anti-alias minimizes imperfections on the selection’s edges, and 

Contiguous will ensure that only the background is selected.  
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With all the magic wand tool settings adjusted, you can start making your selection by 

clicking anywhere in the background of your image.  

 

 
 

To add content to your selection, hold in Shift while clicking on other areas of your 

image. You can also press Shift and then drag over the area you want to add to the 

selection. The goal here is to select the entire background.  

 
 

While making your selection, you may end up selecting more than you should. In my 

case, I was selecting the background and ended up selecting parts of the eagle’s neck.  

 
 

If something like this happens to you, press Alt (Win) or Option (Mac) and click the 

area to subtract the extra content from your selection.  
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Repeat the steps until you finish selecting the entire background. When you’re finished 

selecting your image background, click the layer mask icon at the layers panel to create 

a new layer mask.  
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In the context of graphics, tolerance refers to the acceptable degree of variation or 

deviation allowed in the size, shape, position, or other characteristics of graphical 

elements or objects. It is an important concept in design and manufacturing processes 

to ensure that the final product meets specified standards and requirements. 

Tolerance is primarily applied in two areas: 

Geometric Tolerance: Geometric tolerance specifies the allowable variation in the 

form, size, orientation, and location of geometric features in a design. It ensures that 

the dimensions and relationships between different elements are within acceptable 

limits. Geometric tolerance is often represented using symbols and annotations on 

technical drawings or blueprints. 

For example, a geometric tolerance may specify that a hole should be within a certain 

diameter range, or that two surfaces should be parallel within a specified tolerance 

value. This allows for some degree of variation during the manufacturing process while 

still ensuring the functionality and fit of the final product. 

 

Color Tolerance: Color tolerance relates to the acceptable deviation in color 

reproduction or matching. In graphics and printing, it refers to the allowed difference 

in color between the intended design and the actual output. Color tolerances are defined 

using color spaces, such as RGB (Red, Green, Blue) or CMYK (Cyan, Magenta, 

Yellow, Black). 

Color tolerance accounts for variations in color reproduction due to different devices, 

printing processes, substrates, and lighting conditions. It ensures consistency and 

accuracy in color reproduction across different mediums and production environments. 

b. The Lasso Tool in Photoshop provides an easy way to draw freehand selections around 

an object. This selection tool’s advantage is that it feels a lot more intuitive than other 

selection tools. However, being that it creates freehand selections, it often needs a lot 

of refinement before you have an accurate selection. 

Even though refinement may be necessary, the Lasso Tool isn’t a lost cause. In reality, 

there are various reasons you might way to use this selection tool over others. Let’s 

dive into each of those reasons, as well as how to use the Lasso Tool in Photoshop. 

The Lasso Tool is best used to create selections along simple edges without too many 

bends or curves. Since it creates selections simply by dragging your mouse, it takes an 

extremely steady hand to get an accurate selection. That’s why this tool is best used in 

situations where you need a quick and painless selection method. Something like 

making a selection around a rectangular building or cutting out the smooth edges of a 

coffee cup. 
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Since the Lasso Tool creates paths by following the movement of your cursor, this tool is 

not ideal for making complicated selections. Something like tree branches or hair would 

be an absolute nightmare to cut out with this tool. Instead, it thrives where there are simple, 

well-defined edges that you can easily follow along. 

I tend to use the Lasso Tool for projects that I need to quickly see how a cut out will look 

in another photo. Rather than futzing with a more complicated selection method like the 

Pen Tool, the Lasso Tool gets the job done in less than half the time. Once you have an 

idea of the selection you want, you can always go back in and refine it with a more precise 

selection tool. 

The 3 Types of Lasso Tools 

The Lasso Tool, by itself, is pretty basic and limited in its uses. Luckily, there are three 

different types of Lasso Tool in Photoshop that help to make the selection process much 

easier. All of these tools can be found within the Lasso Tool option or by pressing L on 

your keyboard. You can hold Shift + L to cycle through each of these tools automatically.  
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Lasso Tool  

 
The Lasso Tool is the most basic version you can use. By clicking on a starting point in 

your canvas, simply drag your cursor around your object to create a path. The Lasso Tool 

will follow your mouse’s exact movements all the way back around to the starting point. 

From here, it will create a selection that you can use for layer masks or cutting out the 

image out from the background.  

Polygonal Lasso Tool  

 

Rather than drawing a freehand selection, the Polygonal Lasso Tool creates straight lines 

between each click of your mouse. With this tool selected, you can click on a point to 

begin your path. From here, drag your cursor to another point along your edge to create a 

second anchor point. The Polygonal Lasso Tool will automatically connect these two 

points with a perfectly straight line. If you need to cut out something that’s box-shaped or 

has flat edges, this is the Lasso Tool for you.  

Magnetic Lasso Tool  

 
 

The third type of Lasso Tool is called the Magnetic Lasso Tool. Rather than manually 

selecting where the path will follow, the Magnetic Lasso Tool is a bit more automated. As 

long as you’re going along a well-defined edge in your photo, this tool will automatically 

snap the Lasso Path to the edge. Best of all, this even works along complicated or uneven 

edges like the leaf shown below! The Magnetic Lasso Tool is my favorite version of the 

Lasso Tool in Photoshop and tends to be my go-to while making Lasso selections.  
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Use The Lasso Tool 

To access the Lasso Tool, press L on your keyboard or find it in your toolbar. This type 

of Lasso will be a simple Lasso icon like you’d expect to see in a wild west movie. 

Before you start to make a selection, take a quick look at your upper setting bar and set 

the feather radius you want for your selection. For a nice and sharp edge around your 

selection, leave the feather set to 0px. On the flip side, if you want a nice soft, blurred 

out edge, increasing the feather radius to something like 20px or 30px will do just that. 

Whatever you choose, you’ll need to settle on this before you start to make your 

selection!  

 

Next, make sure your selection type is set to “new selection” by clicking on the solid-

colored square icon. 

 

Now it’s time to create your selection. Click somewhere along the edge you want to 

select and begin to drag your cursor along that edge. The Lasso Tool will create a path 

behind your cursor to be used as your new selection area. 
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From here, you can delete the background, add your selection to a layer mask, or cut 

and copy your selection area for another image. Simply right-click inside of the Lasso 

Tool path to see the options you have available to you 

 

C. Pen tool  

The Pen Tool in Photoshop creates paths and shapes which can be duplicated and 

manipulated to create complex selections, masks and objects. Unlike the Brush Tool 

and Pencil Tools, which “draw” pixels onto your image, the Pen Tool always creates 

a vector path when used. 

You can create multiple paths within an image, and you can create multiple path 

segments within a path. These paths appear as either Work Paths or Shape Paths in the 

Paths Panel.  

The Pen Tool in Photoshop can become your go-to tool every time you need to isolate 

a portion of an image from its surroundings. 

Photoshop’s Pen Tool is an excellent way to remove a product from its background or 

select a portion of a product image to change its color. And you can modify, store, and 

reuse the paths created with the Pen Tool as often as you want. 
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The Pen Tool in Photoshop 

The Pen Tool in Photoshop creates paths and shapes which can be duplicated and 

manipulated to create complex selections, masks and objects. Unlike the Brush Tool 

and Pencil Tools, which “draw” pixels onto your image, the Pen Tool always creates 

a vector path when used. 

You can create multiple paths within an image, and you can create multiple path 

segments within a path. These paths appear as either Work Paths or Shape Paths in the 

Paths Panel. 

Shape Paths vs. Work Paths in Photoshop 

Shape Paths created with the Pen Tool allow you to create custom shapes on your 

image which you can use to call out specific portions of an image. Unlike shapes 

created with the standard Shape Tools (such as the Rectangle Tool or Ellipse Tool), 

shapes created with the Pen Tool can be manipulated any way you want. 

Work Paths, on the other hand, are Photoshop’s way of storing path information 

without applying any color to the path. Once these Work Paths are saved within the 

Paths panel, they can be made into selections, modified, and reused as many times as 

you need. 

By default, the Pen Tool is located in the lower half of the Toolbar. If you click and 

hold on the Pen Tool in the Toolbar, you’ll see six separate Pen Tool options in 

Photoshop CC 2022 (if you’re using an older version of Photoshop, you may only see 

five Pen Tool options).  

 

If you’re not working in the default workspace, some 

of these Pen Tool options may need to be accessed by 

clicking on the three dots at the bottom of the Toolbar 

and adding the extra Pen Tool options to the Toolbar.  

Types of Pen Tools in Photoshop 

In Photoshop CC 2022, there are four different Pen 

Tools you can use to create a new path: 

The standard Pen Tool 

The Curvature Pen Tool 

The Freeform Pen Tool 

The Magnetic Pen Tool (only visible by adjusting the settings of the Freeform Pen 

Tool) 

The other Pen Tool options are used to modify an existing path. Those tools are: 

The Add Anchor Point Tool 

The Delete Anchor Point Tool 

The Convert Point Tool  
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The Pen Tool in Photoshop can become your go-to tool every time you need to isolate 

a portion of an image from its surroundings. 

Photoshop’s Pen Tool is an excellent way to remove a product from its background or 

select a portion of a product image to change its color. And you can modify, store, and 

reuse the paths created with the Pen Tool as often as you want. 

The Paths Panel in Photoshop 

The Pen Tool and the Paths Panel go hand in hand, so you’ll need the Paths Panel to 

be visible when you begin to use the Pen Tool. 

In the Essentials (default) workspace, Paths are accessible by clicking on the Paths tab 

visible in the Layers Panel. If you don’t see a Paths Panel in your workspace, you can 

access Paths by clicking on the Windows dropdown menu and selecting Paths. 

 

The Standard Pen Tool 

We’ll use the standard Pen Tool for the paths we’ll be creating in this exercise. It’s the 

original Pen Tool and is very similar to the Pen Tool in Adobe Illustrator. You 

can create just about any kind of path with this tool. 

 

The Freeform Pen Tool 

The Freeform Pen Tool allows you to draw with the Pen Tool in the same way you 

would draw with the brush tool, creating a path as you draw. 

 
The Magnetic Pen Tool 

https://pathedits.com/blogs/tips/step-by-step-guide-remove-background-photoshop
https://pathedits.com/blogs/tips/how-to-create-a-clipping-path-in-photoshop-2021
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With the Freeform Pen Tool selected, you can check the Magnetic option at the top of 

the application window and access the Magnetic Pen Tool. 

 

The Magnetic Pen Tool works much like the Magnetic Lasso Tool, allowing you to 

trace the exterior of a shape within your image. It’s not perfect, however, so we suggest 

you work with the Standard Pen Tool whenever possible. 

The Curvature Pen Tool 

The Curvature Pen Tool automatically lays down curves between points as you draw 

your path. This is a great tool to use if the path or shape you want to create has curved 

edges. You can always adjust the curves after the path is created by using the selection 

tools and modifying tools discussed below. 

 
The Add Anchor Point Tool 

The Add Anchor Point Tool gives you the ability to add more points onto your path 

once it’s been created. Hover the Add Anchor Point Tool over the part of the path 

where you want to add a new point and click the mouse to create the point. 

 
The Delete Anchor Point Tool 

The Delete Anchor Point Tool removes points from your path after the path has been 

completed. Hover your cursor over the point you want removed and click the mouse to 

delete the point from the path. 

 

The Convert Point Tool 

The Convert Point Tool is extremely useful. If you have a point forming a sharp corner on 

your path and you want to convert that corner to a curve, clicking the Convert Point Tool 

will make that happen. Conversely, the Convert Point Tool will remove a curve from a 

point and convert the point to a corner. 

 

Paths vs. Shapes in Photoshop 

Path refers to a vector-based outline or shape created using the Pen Tool or Shape Tools. 

Paths are comprised of anchor points connected by straight or curved line segments, 

allowing for precise control over the shape and contour of an object. 
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When you access either the standard Pen Tool, the Curvature Pen Tool or the Freeform 

Pen Tool, you can set your Pen Tool setting to either Path or Shape in the options bar at 

the top of the application window. 

Drawing with the Pen Tool when Path is selected creates a new Work Path that appears in 

the Paths Panel. Drawing with the Pen Tool when Shape is selected creates a new Shape 

Path that appears in both the Paths Panel and the Layers Panel. 

 

When you choose Shape, you can also change a few different settings, including stroke 

color, thickness and fill color of the shape. We’ll go over the specifics of creating a shape 

with the Pen Tool at the end of this article.  

 

When you choose Path, you’ll see an icon that looks like two small overlapping squares 

(this icon is also available when Shape is chosen once you’ve already begun drawing your 

path). If you’re creating an initial path to become a selection, set this option to Combine 

Shapes. 

You’ll see a few other icons in the options bar, but for the purposes of this tutorial, you 

should leave those at their default values.  

To start your path, click on your image with your mouse where you want to begin your 

path. To keep things simple, choose a starting point that is at the edge of a straight line, 

such as the edge of the top of the sock in the image below. 

Click again along the edge of your object with the Pen Tool to draw the first segment of 

your path. You should now see a straight line appear. 

Also, note a Work Path appears in the Paths panel as soon as you place the second point.  

Create a curved path segment with the Pen Tool 

To create a curve with the standard Pen Tool (such as the curves at the ankle of the sock), 

click to create the next point and drag with the Pen Tool before you release the mouse 

button. You’ll see lines, called handles, appear.  
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Anchor Handles: Anchor handles, also known as direction handles or control handles, are 

used to control the curvature and direction of the path between anchor points. They extend 

from the anchor points and can be adjusted to modify the shape of the path. By dragging 

the handles, you can change the length and angle of the handles, thus altering the curvature 

of the path segment. 

Anchor handles come in two types: 

Hard Handles: Hard handles have a straight, linear shape without any curves. They provide 

a sharp and abrupt change in direction at the anchor point, creating a corner or straight 

segment in the path. 

Soft Handles: Soft handles have curved shapes. They allow for smooth transitions and 

gradual changes in direction, resulting in a curved segment in the path. 

The combination of anchor points and their associated handles allows you to create and 

manipulate complex paths with various shapes, curves, and angles using the Pen Tool in 

Photoshop. By adjusting the position and length of the handles, you can achieve precise 

control over the path's appearance, resulting in smooth curves or sharp corners, depending 

on the desired effect. 

These handles are tangential to the curve being formed by the path. Moving the mouse 

around will adjust the handles, which will then adjust the line’s curvature. Once you’re 

satisfied with the shape of the curve, release the mouse button. 

Note the handles formed from the curved line appear before and after the point. Therefore, 

the next portion of the path that you draw after creating a curved line will follow the 

trajectory of the handle from the last point.  
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When you click the next point, drag the mouse to create new handles and modify the curve 

that appears with your new point.  

 

Closing your path with the Pen Tool 

Once your path is complete, close your path by hovering the Pen Tool over the very first 

point you set down. When you see a small circle appear to the right of the Pen Tool, click 

on the point.  
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2. Clipping Path  

Create a Clipping Path in Photoshop 

Clipping path is a vector path or shape that creates an outline around the edges of an object 

to cut that out. It is called deep itching too. This is basically the process of separating one 

part of an image from another. 

In photoshop, we can mark the edges of an image by using a pen tool. The points that 

create lines around the intended area are called anchor points. Anchor points create 

clipping path by connecting one after another. 

There are three kinds of clipping paths – 

Single Layer 

Single layer clipping path means drawing a simple easy path around the hard edge of an 

image. This kind of layer is usually used to remove or change the background of an image. 

In the case of a single layer, the clipping path is drawn on the same layer. 

Multi-Layer 

Creating multiple paths on different layers in photoshop is called multi-layer. Multi-layer 

is most useful for retouching images or editing specific parts of an image. While a single 

layer cuts out one single subject from an image, multi-layer separates more than one 

subject from the same image. 

Illustrator Path 

Illustrator clipping path is making one or more vector shapes following the subjective path 

of the image. When you need to resize an image but you’re also concerned about the 

resolution and you don’t want to ruin it, you can use illustrator clipping path for that. 

Tutorial: How to Create Clipping Path in Photoshop 

It’s not that tough to create clipping path in photoshop. There is one tool that you need to 

learn to control to do clipping, and that is pen tool. Here, is the explanation of doing 

clipping in step by step: 

Step 1: Open file 

Launch photoshop on your pc and open the file in adobe photoshop. 

 
Step 2: Pick pen tool 

Next, go to the toolbar menu and select the pen tool. 



 

23 

 

 
Step 3: Create anchor points 

After taking the pen tool, at first, zoom your image to see the edges clearly. You can keep 

it around 300%. This will allow you to draw the path accurately. Now, start pointing the 

edges of the object you want to cut out. These points are called Anchor points. Keep 

marking till you reach the starting point. 

 
When you’re separating one object from another, you need to be careful with the edges to 

give it a natural look. So mark as perfectly as possible. 

Step 4: Inside Path 

The image that’s taken here, has another empty space inside the handle. So we’ll have 

to create another path inside. 

 
Step 5: Save path 

When you’re done with the marking, go to the layer panel. Then select the path tab. 

Now, go to the menu on the top left corner and select save path. And name the path as  
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‘Path 1’. 

 
Step 6: Clipping path 

Go to the same menu and select Clipping Path. 

 
A box will pop up showing some options. There is one box called Flatness. Flatness is the 

count of the closeness of the clipping path to the edge of the image. This determines the 

smoothness of the image. 

An increased value of the flatness makes the edge blur. If the value is lesser, the edge will 

be smoother and sharper. 

 
Step 7: Save your photo 
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Finally, save your image. You can use this file later to make any changes there. Or you 

can send it to someone else too, the path will be there and they can use it according to their 

need. 

 
Don’t forget to save both the psd and jpeg files. This will give you access to use this 

image in whichever way you want. 

 
To Remove Background  

After saving the photo, you can use the image anytime for whatever change you want to 

make. For example, you can change the background from this image. Once you’re done 

with making the clipping path, click on the right button of your mouse and click on ‘make 

selection’. 

 
Now add a layer mask and your background is removed. 
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Removing Image Background 

the "Feather" option refers to a feature that allows you to soften the edges of a selection, 

layer mask, or a shape. By applying feathering, you can create smooth transitions and 

blend selected areas or objects more seamlessly with their surroundings. 

The Feather option is typically accessed through the Selection Tool (such as the Marquee 

Tool or the Lasso Tool) or when creating a layer mask. Here's how it works: 

Selection Feathering: 

Make a selection using any of the selection tools in Photoshop. 

In the options bar at the top of the screen, you'll find the Feather field or Feather slider. 

Enter a pixel value or slide the slider to specify the amount of feathering you want to apply. 

A higher value will result in more significant feathering and softer edges, while a lower 

value will yield less feathering and sharper edges. 

Once you've set the feather value, make adjustments or apply effects within the selection, 

and the edges will appear blended or softened. 

Layer Mask Feathering: 

Create a layer mask on the layer you want to mask. You can do this by selecting the layer 

and clicking on the Layer Mask icon at the bottom of the Layers panel. 

With the layer mask selected, go to the Properties panel (Window > Properties) or right-

click on the layer mask and choose "Feather." 

Enter a feather value or adjust the feather slider to control the softness of the mask's edges. 

The layer mask will now have feathered edges, allowing for smoother transitions and 

blending with the underlying layers. 

 

First of all, this is mostly used to remove the background of an image. If you want to 

remove the background, change the color of the background or to make an image 

transparent background, you’ll have to do the clipping before that. 

Retouching or Color Correction 

Another use is while doing retouching or photo color correction. Clipping path lets us 

select a particular area or separate that from the image, that way we get to edit that 

particular place separately. 

Removing Unwanted Parts 

Moreover, removing unwanted parts from the image is another vital use of the clipping 

path. It’s not unusual to have unnecessary parts in an image while shooting. If you want 
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to remove those parts from your image, you’ll have to create the path first and then remove 

it from your image. 

Restoration or Manipulation 

The clipping path in photoshop is useful in the restoration and manipulation of the image 

too. Touch up in an image requires clipping. Same in masking. You’ll have to do clipping 

first if you want to do masking. 

Removing background, color correction or retouching, all are necessary in photoshop 

editing. In e-commerce product photography, the purpose of doing all these is to produce 

a high-quality, clean yet natural looking image. The image plays such an important role in 

the e-commerce business to attract viewers and increase sales.  
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Self Check Sheet 1.1 

1. Why we use Magic Wand Tool? 

 

 

2. What is Pen Tool  

 

 

 

3. Write the the name of 4 image separation Tools. 

 

 
4. Why we use Add Anchor Point Tool? 

 

 

 

5. What is Path? 
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Answer Key 1.1 

1. Why we use Magic Wand Tool? 

Answer: The Magic Wand Tool allows you to select areas of similar color or tone in 

an image. By clicking on a specific area, the tool selects contiguous pixels with similar 

attributes, making it useful for selecting and separating specific regions of an image. 

2. What is Pen Tool  

Answer: The Pen Tool is a versatile tool that allows you to create precise paths and 

selections by placing anchor points and adjusting curve handles. You can manually 

trace the contours of an object to create a path, which can be used for separation or to 

create complex selections 

3. Write the the name of 4 image separation Tools. 
Answer:  

1. Magic Wand Tool:  

2. Pen Tool:  

3. Lasso Tool 

4. Background Eraser Tool 
4. Why we use Add Anchor Point Tool? 

Answer: The Add Anchor Point Tool gives you the ability to add more points onto 

your path once it’s been created. Hover the Add Anchor Point Tool over the part of 

the path where you want to add a new point and click the mouse to create the point. 

5. What is Path? 

Answer: Path refers to a vector-based outline or shape created using the Pen Tool or 

Shape Tools. Paths are comprised of anchor points connected by straight- or curved-

line segments, allowing for precise control over the shape and contour of an object 
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Activity Sheet 1-1:  

 

Task Name: Saperate image from the background using Pen Tool. 

Working Procedure: 

1. Follow OSH and Ergonomics requirement 

2. Run Computer and Open Adobe Photoshop. 

3.  Collect sample image 

4. Remove background of the following sample image. 

5. Place it another background. 

6. Save your work at PSD and JPEG file format. 

7. Close all application and Close computer. 
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Job Sheet 1.1 

 

Job Name: Retouch the image and separate the image from the background using the 

background erager tool  

 

Job Stepes/ Procedure 

1. Follow OSH and Ergonomics requirement 

2. Run Computer and Open Adobe Photoshop. 

3.  Collect sample image 

4. Remove background of the following sample image. 

5. Place it another background. 

6. Save your work at PSD and JPEG file format. 

7. Close all application and Close computer 

 

Sample job 
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Specification Sheet 1.1 

Job Name: Retouch the image and separate the image from the background using the 

background erager tool 

 

Condition for the job: 

 

1. Place it in a 4-inch rectangular frame on a different background. 

2. Frame Size: 4” × 4” 

3. Frame border: 0.5” 

4. Frame color: Blue  

5. File Save in PSD and JPEG format.  

To complete the above task, you will need to following equipment per Trainee. 

Required Tools and equipment 

S/N Name of item Specification Unit Quantity 

01 
Personal Computer Latest Configuration Nos 

1 

02 Keyboard and Mouse Standard Nos 1 

03 Monitor Standard Nos 1 

04 Adobe Photoshop Latest version Nos 1 

Raw Materials 

• N/A 

Required PPE 

• Ergonomic chair 

• Eye protective glass 

• Rubber shoe 
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Learning Outcome 2: Create a Composition  

Content: 

1. Image composition 

2. Images editing 

a. Transform 

b. Transparency 

c. Gradients 

d. Strokes 

e. Adjustment 

f. Crop 

g. Filter 

h. outline 

i. Blending option 

Assessment Criteria:  

1. New document is created 

2. Images are pasted for edit 

3. Layers are created and selected. 

4. Images are edited and arranged. 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 
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Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
  



 

35 

 

Learning Experience 2: Create a composition 

In order to achieve the objectives stated in this learning guide, you must perform the learning steps 

below. Beside each step are the resources or special instructions you will use to accomplish the 

corresponding activity. 

 

Learning Steps Resources specific instructions 

1. Student will ask the 

instructor about Apply 

Graphic Design 

Concepts and 

Guidelines. 

1. Instructor will provide the learning materials 

“Separate and Compose Images 

2. Read the Information 

sheet/s 

2. Information Sheet No:2 Create a composition 

3. Complete the Self 

Checks & Check answer 

sheets. 

3. Self-Check/s 

Self-Check No: 2 Create a composition 

Answer key No. 2 Create a composition 

4. Read the Job Sheet and 

Specification Sheet and 

perform job 

4. Job- Sheet No:2-  

 

Specification Sheet 2 –  
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Information Sheet 2: Create a composition 

Learning Objectives 

After completion of this information sheet, the learners will be able to: 

1. Create new document 

2. Edit pasted Images 

3. create and select Layers are. 

4. Edit and arrange Images. 

1. Image composition 

Image composition, in the context of visual arts and photography, refers to the 

arrangement and organization of various elements within an image to create a visually 

pleasing and balanced composition. It involves the deliberate placement, framing, and 

combination of subjects, objects, lines, colors, and other visual elements to convey a 

particular message, evoke emotions, or guide the viewer's attention. 

Layer: 

In Adobe Photoshop, a layer is a fundamental component of the software's workflow and 

refers to a transparent, stackable element within an image. Layers allow you to work on 

different parts of an image independently, making it easier to manage, edit, and manipulate 

various elements without affecting the rest of the image. 

Create New Document in Photoshop 

You can create a New Document by using one of several options available in Photoshop. 

Follow these steps to create a New Document: 

Open Photoshop If you are using Photoshop CC, you will have your Home Screen opened 

up. This screen keep on changing from time-to-time.  

 
Choose File – New or press Ctrl + N (cmd + N) Either way, the New Document dialog 

box opens. 
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Modify the setting, before creating the New Document, in the preset from right pane. You 

have several options as choice:  



 

38 

 

 

Preset: ‘Photo’, ‘Print’, ‘Art & Illustration’, ‘Web’, ‘Mobile’ and ‘Film & Video’ 

Name: Specify a file name for New Document 

Width and Height: Specify the size of the New Document. Also chose the unit from the pop-

up menu. 

Orientation: Preferred page orientation for the New Document: Landscape or Portrait. 

Artboards: This option adds artboard while creating the New Document. It can also be added 

later. 

Color Mode & Bit: Chose color mode for the New Document. Out of five color modes 

available, you will mostly use CMKY (for print purpose), RGB (for digital purpose) and 

Grayscale (for Black and White) (occasionally) in 8 bit. 

Resolution: It determines the quality of an image. For digital purpose, you should use 72 ppi 

(pixel-per-inch). For print purpose, you should use 300 ppi (industrial standard resolution). 

Background Contents: The default value for a New Document is White but you can choose a 

different color from the options. 
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To specify the extra options, click Advanced Options. 

 
Color Profile: Chose color profile for your New Document from a wide variety of options. 

Pixel Aspect Ration: The ratio of width to height of a single pixel. 

Click ‘Create’ button after setting all options to create the New Document.  

 

 

Create Composite Photography in Photoshop  

Composites are also heavily frowned upon in some photography competitions. It is especially 

evident in competitions like the Wildlife Photographer of the Year awards. The rules specify 

that ‘entries must not deceive the viewer’ or ‘attempt to disguise or misrepresent the reality of 

nature’. Therefore, you must be as transparent as possible in your use of composite 

photography and know when it’s appropriate to use it. Do not use it for editorial 

photography but use it freely with fine art photography. 
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Planning and Preparing to Create Composites 

Step 1:  

In composite photography, concept is everything. And you are only limited by what your mind 

can think of. The hardest thing will probably be managing what you have in your head and 

translating it into set images in a fixed frame. The easiest way to do this is to separate your 

vision into a few categories: 

• the subject 

• the background 

• the extras 

• the atmosphere 

The most important details are the subject and the background. Once you have a simple idea, 

you can build in other things that add to this idea. Maybe the person on the desk is sitting 

down with lego figures their size. It is all about creating a narrative through the control you 

have. 

 

Step 2: Choose Images With the Following Characteristics 

Collecting images for a composite is not as simple as choosing the best photographs. There 

are a few things you need to take into consideration: 

1. Appropriate File Sizes and Resolution 

Make sure that the background is big enough to zoom into the picture and work on the 

elements inside without the image pixelating. This also goes for the subject image you are 

choosing. Can it be scaled up to fit in the background without it pixelating? 

If it is just going to be used for web purposes, having images as little as 10cm in length at 
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72 dpi will work. You probably want around 20cm in length at 300 dpi for print. I would 

recommend the latter option as an excellent go-to size for composite images. 

2. Similar Perspectives 

Perspective is arguably the most crucial factor in making a composite image. If you have a 

photo of a subject looking up at them, but the background is taken level or at a high up 

perspective, it won’t look right putting them together. It is best already to have the final 

background image in your mind (or the other way round). This means you will be able to 

photograph your subject (or background) with the same perspective and in a believable way. 

For instance, if you’re photographing someone as if they have shrunk into the palm of a hand, 

you will most likely be looking down on them. So get up on a ladder or shoot out of a window 

to try and mimic this angle.When sourcing images, you will want to ensure that all the 

elements are taken with a similar perspective. 

3. Similar Lighting 

Lighting is the most common way that you will be able to spot a composite image. In 

advertisements, you can sometimes tell that the lighting is too perfect on someone in the 

middle of the frame. There is no way anyone could get this effect with studio lighting. In 

lesser, refined edits, there can be even clearer giveaways. There may be a background that is 

clearly in a basement with no windows, yet there is harsh directional lighting. Even if there is 

a light source in the image, people will sometimes mistakenly put the subject where the light 

cannot fall onto this person. Being meticulous in determining the direction of light in all 

images you use in your composite photography will go a long way. Of course, you will be 

able to get away with lighting not being 100% perfect. But, every tiny detail you cover will 

go a long way. 

4. Similar Color Temperatures 

The color cast in your photos will also profoundly affect your composite. Each separate image 

will most likely have been taken in a different light if you think about it. Different kinds of 

light have different color temperatures. This means cut out sections will not look like they are 

under the same light as the background image. Often, it will require just a tiny change to the 

color temperature to match. It is usually a case of making the subject warmer or colder (more 

yellow or blue). 
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2. Images editing 

Step-By-Step Guide to Create Photoshop Composites 

We will now go through a short step-by-step approach to a simple Photoshop composite. 

I will introduce a few quick and easy techniques to apply to various situations. This edit 

should take you under five minutes to do! 

I will use two stock images for this demonstration. Both I took from the stock image 

site Unsplash. I will also later use a brush I downloaded from Brusheezy. 

Step 1. Select Subject and Background Images 

First, I make a plan for my final image. I want to composite people doing yoga in an 

extreme place. So I find a yoga pose first (subject). 

 

 



 

43 

 

 

Now I want to find an extreme place like a cliff (background). When looking for the cliff 

image, I consider the camera’s perspective in the yoga photo. The yoga picture looks straight 

at the subject from their body height. This means I pick a location where I can place the 

subjects on the same level or even slightly higher. This cliff will work great. 

 

Step 2: Cut Out the Subject 

Now we start the editing process. First, open up your subject image in Photoshop. 

 

Then duplicate the background. 
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You can right-click the original image (Background layer) in the Layer panel and click 

Duplicate Layer. 

Or you can drag the Background layer over the Create new layer icon (+ sign) on the 

bottom. 

 

 
Now we will cut out the two women. There are many ways to do this. As this is a quick 

guide, I will use the Quick Selection tool in the toolbar (paintbrush icon with a dotted 

circle). Start to click on your subject so that the ‘marching ants’ snap to outline your 

subject.  

Do this for both people. Make sure to use the subtractive brush (with a minus sign) to take out 

the gaps between their bodies. 
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Now you want to inverse the selection. I do this by holding down Command or Ctrl+Shift+I. 

The ‘marching ants’ should now go around the border of your image as well. With the 

duplicate background layer selected, press the Backspace or Delete key to cut out your subject. 

This is how your duplicate layer should look. You can ‘hide’ the original image by pressing 

the Eye icon in the layers panel. 

Step 3: Move the Subject onto the Background 

Next, open your background image in Photoshop. You will have separate tabs of the two files 

you are working on. 

With the subject image selected, double-click on your cut out layer. Then drag it onto the tab 

of the new background image, which will open. 
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Step 4: Resize and Position the Subject Image 

First, you want to resize the subject. Press Command or Ctrl+T to open the transform box 

and resize the image. Make sure your subject is a believable size. In my example, I make 
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sure the height of the people is realistic.

 

Then use the Move tool (V) to place the subject correctly. Here, I put the women on top of 

the cliff. This is the base of our simple composite image. 

 

Step 5: Create a Layer Mask to Match Color Tones 
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Now you want to create a layer mask for your subject. I’ll use it to fine-tune the color of the 

subject images. But you can adjust many kinds of details using a masking technique. Grab 

your subject layer and drag it over the ‘Add a layer mask’ button at the bottom of the Layers 

panel. 

Next, in the Adjustments panel, click the Color Balance icon. This opens an adjustment layer 

for color balance 

Now you want to drag your layer mask onto this new adjustment layer. If a pop-up box comes 

up, press yes to replace the layer mask.As the background image has a cold and blue look, I 

add a blue tone to the subject. 
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This makes a subtle difference, but that difference goes a long way. 

Step Six: Add Extra Effects to Create a Compelling Scene 

I want to add some fog for an atmospheric effect. You can choose other effects based on 

your images.  

For this fog effect and others, you can find fog brushes online. Download the tools and 

import them into Photoshop. 

First off, you want to create a new layer (‘Layer 1’) for the effect. Click the new layer button 

(+ sign) at the bottom of the Layers panel. 

Then choose the Brush tool. And select the type of brush you want to use in the Brush 

Picker in the top menu bar. 
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When working with fog brushes, lower the opacity and flow of your brushes. This ensures a 

light effect and application.Gradually, start bringing in the fog by brushing it in. Make it 

look as natural as possible.  
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Do this all around the image. Make sure you use different brushes or change the brush 

direction to add variation.For illustrative purposes, this is what your layer should look like if 

you applied a black background for the fog. (You don’t have to apply a black background to 

this layer.) 

For fine-tuning the final image, you will want to erase the fog that’s in the way. Select the 

Eraser tool from the toolbar. 

Again, you will want to make sure the opacity and flow are low, so you can lightly blend the 

fog out. 

 
Now you have a quick and easy Photoshop composite photo 
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Self Check 2.1  

Answer the following questions: 

1 What is image composition? 

Answer: Image composition, in the context of visual arts and photography, refers to the 

arrangement and organization of various elements within an image to create a visually 

pleasing and balanced composition. 

2 What is layer in Photoshop? 

Answer: In Adobe Photoshop, a layer is a fundamental component of the software's 

workflow and refers to a transparent, stackable element within an image. Layers allow 

you to work on different parts of an image independently, making it easier to manage, 

edit, and manipulate various elements without affecting the rest of the image. 

3 Why we use filter to edit image?  

Answer: Filters are powerful tools that allow you to apply various effects and 

modifications to your images. Filters can alter the appearance, texture, color, or overall 

look of an image, providing creative enhancements or corrective adjustments. They can 

be applied to an entire image or specific layers, selections, or smart objects. 
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Answer Sheet 2.1 

1. What is image composition? 

Answer: Image composition, in the context of visual arts and photography, refers to the 

arrangement and organization of various elements within an image to create a visually 

pleasing and balanced composition. 

2. What is layer in Photoshop? 

Answer: In Adobe Photoshop, a layer is a fundamental component of the software's 

workflow and refers to a transparent, stackable element within an image. Layers allow 

you to work on different parts of an image independently, making it easier to manage, 

edit, and manipulate various elements without affecting the rest of the image. 

3. Why we use filter to edit image?  

Answer: Filters are powerful tools that allow you to apply various effects and 

modifications to your images. Filters can alter the appearance, texture, color, or overall 

look of an image, providing creative enhancements or corrective adjustments. They can 

be applied to an entire image or specific layers, selections, or smart objects. 
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Learning Outcome 3: Retouch Image 

Content:  

1 Retouching 

2 Retouch tools  

a. Healing brush tool 

b. Spot Healing 

c. Patch Tool 

d. Clone Stamp Tool 

3 Tools calibration  

4 Layers creation and preservation 

5 Images correction 

6 File format 

Assessment Criteria:  

1 Appropriate retouch tools are identified 

2 Tools are calibrated as required 

3 Layers are created and preserved 

4 Retouch tools are used as per requirement 

5 Images are corrected and saved in appropriate file format 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 Methodologies  

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

Assessment Methods 

•  Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 3 

Learning Objectives 

After completion of this information sheet, the learners will be able to: 

1 Appropriate retouch tools are identified 

2 Tools are calibrated as required 

3 Layers are created and preserved 

4 Retouch tools are used as per requirement 

5 Images are corrected and saved in appropriate file format 

1. Retouching 

Image retouching refers to the process of altering or enhancing an image to improve its 

appearance or correct imperfections. It involves making selective adjustments, removing 

or reducing flaws, and enhancing specific areas to achieve a desired visual result. Image 

retouching can be performed using various software applications, with Adobe Photoshop 

being one of the most popular tools for this purpose. 

Here are some common techniques used in image retouching: 

Skin Retouching: Skin retouching aims to create smooth and flawless skin by reducing 

blemishes, wrinkles, acne, and other imperfections. It involves techniques like spot 

healing, cloning, frequency separation, and dodge and burn to even out skin tones, remove 

spots, and enhance texture while maintaining a natural appearance. 

Color and Tone Adjustments: Image retouching often includes adjustments to colors, 

tones, and contrast to improve the overall visual impact. This can involve adjusting 

brightness, contrast, saturation, and levels, as well as selectively modifying colors to 

achieve a desired look or correct any color issues. 

Object Removal or Addition: Image retouching may involve removing unwanted 

objects, people, or distractions from the image. This can be achieved using tools like the 

Clone Stamp tool or Content-Aware Fill in Photoshop. Conversely, objects or elements 

can also be added to an image for creative purposes or to enhance the composition. 

Sharpening and Noise Reduction: Retouching can include sharpening specific areas to 

enhance details and make the image appear crisper. Conversely, noise reduction 

techniques can be applied to reduce unwanted digital noise or graininess in images, 

particularly in low-light or high-ISO photographs. 

Reshaping and Body Contouring: In portrait or fashion retouching, it is common to 

perform subtle reshaping or body contouring adjustments to enhance the subject's 

appearance. This can involve slimming down or sculpting body parts, adjusting facial 

features, or enhancing proportions while maintaining a natural look. 

Background and Composition Enhancements: Image retouching may also involve 

modifying or enhancing the background or composition of an image. This can include 

adjusting lighting, adding or removing elements, adjusting perspective, or creating a more 

visually pleasing and balanced composition.  
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2. Retouch tools 

Adobe Photoshop has some of the best tools for removing unwanted objects from your 

image. 

In this article, we take a deep dive into the Spot Healing Brush tool. This powerful tool is 

also the easiest one to use. Just click a spot, and Photoshop does the rest. Both the Spot 

Healing Brush and the Healing Brush are used for small blemishes in your photo. If you 

have a larger object to remove, use the Patch tool. 

Effective Editing Techniques 

 

Digital Dreamworlds 

Want to take your spot healing brush tool skills to the next level? Our eBook and Cheat 

Sheets provide expert instruction on creating surreal digital photo collages. 

Buy from ExpertPhotography 

Spot Healing Brush Tool vs. Healing Brush and Clone Stamp Tool 

It is easy to get the Spot Healing Brush and the standard Healing Brush tools confused in 

Adobe Photoshop. Even the icons look similar. The Spot Healing Brush is in the toolbar. 

It may be nested with other tools like the Healing Brush, Patch, and the Content-Aware 

Move tool. Click one of these tools to see a fly-out menu. 

 

When you select the Spot Healing Brush tool, an options bar appears above your image. 

You have control over the size and hardness of the brush, the blending mode, and the type 

of Spot Healing Brush. You also have the option to sample all layers and select a brush 

angle. 
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Both the Spot Healing Brush and the Healing Brush replace pixels in your image. First, 

identify a problem area in your photo. This can be a pimple, a dust spot, or a piece of trash. 

The difference in the tools lies in how the program chooses new pixels to replace the 

problem area. With the Healing Brush, you identify the replacement pixels. Click on a 

clean area holding the Option key. This tells Photoshop to use these pixels in place of the 

problem ones. With the Spot Healing Brush, Photoshop uses an algorithm to work out the 

best pixels to use. With both healing brushes, Photoshop blends the new and old pixels. 

The Clone Stamp tool is like the healing brushes. But Photoshop does not blend the new 

and old pixels for a seamless patch. 

You may feel like you have more control when using the Healing Brush. But Photoshop 

can search your image at the pixel level to find clean replacement pixels. These may be 

better than the ones you choose. 

How to Use the Spot Healing Brush 

The Spot Healing Brush is used to remove small blemishes or objects. Blemishes may 

include acne or dust spots in the sky. Small objects may include trash or power lines. We 

will start by removing a few dust spots. 

Step 1: Create a Blank Layer 

Create a blank layer by clicking the + sign below the layers panel, or you can go to the 

Layer drop-down menu and select Layer > New > Layer (shift + ⌘N). Rename this layer 

‘Spot Healing’. Healing on a separate layer safeguards your original photo. Toggle the 

Spot Healing layer off to see your original image. 

 

Create a new layer by clicking the + button or selecting New > Layer in the Layers drop-

down menu 
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Step 2: Zoom In 

You can see the edges of the spot more clearly when you zoom in. You are also less likely 

to miss spots if you magnify the image. Click the Magnifying Glass tool. Then click on 

the screen repeatedly until you can easily see the place that needs repair. 

You can also zoom in by pressing the Command key and the + symbol. To return to the 

full-sized image, click Command – or Command 0. 

 

Zoom in to see the problem area more clearly. Dust spot circled to make it more obvious. 

Step 3: Select Spot Healing Brush 

Select the Spot Healing brush from the Photoshop toolbar. Make sure you select the Spot 

Healing brush and not the Healing brush. In this image, I am going to remove dust spots 

in the sky. 
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Open the Spot Healing Brush tool found on the toolbar 

Step 4: Size the Spot Healing Brush 

The Spot Healing Brush tool appears as a circle in your workspace. Move the circle over 

the spot you want to remove. Then, make the Spot Healing Brush slightly larger than the 

spot. You can change the size on the Options bar. Click the fly-out menu. Slide the Size 

slider left to make the brush smaller and right to make the brush larger. You can also 

change the size of the brush using the bracket keys [ ]. The left bracket key [ makes the 

brush smaller. The right bracket key ] makes the brush larger. 
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Size the brush slightly larger than the spot using the menu on the options bar 

In the brush menu, you can also change the softness of the brush. A soft brush feathers the 

edges. With a harder brush, the edges will be sharp and noticeable. A softer brush usually 

gives better results. 

Step 5: Choose Brush Type 

There are three Spot Healing Brush types: Content-Aware, Create Texture, and Proximity 

Match. Content-Aware is the newest addition to the line-up. Photoshop looks at your 

image and figures out what content to use. When using Proximity Match, Photoshop looks 

at the pixels just outside of the Spot Healing Brush circle for replacement pixels. With the 

Create Texture option, Photoshop generates a pattern from the pixels around the area you 

want to replace. Content-Aware will usually give you the best results. But if you do not 

get results you like, try using one of the other types. 

 

Removing the rock with Content-Aware gave me the best results. Create Texture added 

artifacts to the water. Proximity Match made no difference. 

Step 6: Check Sample All Layers Box 

Check the Sample All Layers box. The tool will sample from the background layer. 

Unchecking the box limits sampling to the selected layer. In this case, the selected layer 

is blank. 

 

Check the Sample All Layers box 

Step 7: Remove Spot 

Make sure you have the Spot Healing layer selected. Click once on the spot that you want 

to remove. If the spot does not disappear, choose a different type of Spot Healing Brush, 

and click on the spot again. 
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How to Remove a Line 

The Spot Healing Brush tool works well to remove isolated dust spots or facial blemishes. 

But you can also drag the tool to remove a line, like power lines, from your image. 

The default settings in the options bar work well for removing a single spot. But when 

removing larger objects, or a line, you may need to change the spacing, mode, or the type 

of healing brush. 

Spacing 

When you drag the Spot Healing Brush, the tool creates multiple brush strokes. Spacing 

is how far apart two brush strokes are. Set to less than 25% for a clean repair. Spacing 

higher than that will leave gaps in the repair. 
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When dragging Spot Healing Brush, set the spacing to under 25% 

Blend Mode 

We have already talked about changing the type of Spot Removal Brush to get optimal 

results. On the Options bar, you can also change the blend mode. This is how the new 

pixels blend with existing pixels. Normal is the default, but you also have search, Multiply, 

Screen, Darken, Lighten, Color, and Luminosity. They will interact differently with your 

image. If you are not getting the result you want, change the blend mode. 

 

Compare the results when removing power lines using different blend modes 

Tips for using the Spot Healing Brush tool 

If you are not getting good results from the Spot Healing Brush, here are a few tips for 

using the Spot Healing Brush tool. 

Spot vs. Line 

The Spot Healing Brush will remove a line, but it works better when you click once to 

remove an object. When possible, make your Spot Healing Brush larger than the object 

you are removing and click once rather than dragging. 

Change Direction 

If you are removing a line, change the direction of the brush stroke. Instead of moving left 

to right, move right to left. If you are moving upwards, try starting at the top and move 

downwards. If you are moving from the center outwards, try starting at the edge of your 

frame. 

Change Size of Brush 

If your brush size is not quite large enough, the Spot Healing Brush may repair the center 

and leave a ring. Change the brush size to make it larger than the spot. 

Remove Smaller Sections 

If you are removing a large object or a long line, try healing smaller sections. When 

removing large patches of facial blemishes, start by removing smaller sections. When you 

have more clean skin, you can tackle the larger problem. Don’t be in a hurry. 
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Spot Remove Again 

Sometimes clicking on a spot a second time will give cleaner results. Try a different-sized 

brush or a different type of brush. But going over the same area too many times will 

introduce artifacts. 

Also, watch for a repeating pattern. This draws the eye and is a giveaway that you have 

changed the image. If Photoshop throws up a repeating pattern, go over the spot again to 

remove it. 
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Use the Clone Stamp Tool 

You can find the clone stamp in the tool bar on the left hand side. The shortcut for the 

clone stamp for both Mac OS and Windows is S.  

  

If you can’t see the tool bar on the left, make it visible using the ‘Window’ menu. 

Click on ‘Tools’ all the way down in the menu.  

 

  

Remove Unwanted Objects With the Clone Stamp Tool 

Imperfections or distractions could mess up a great fashion or publicity photo. Luckily, 

removing them with the clone stamp tool is easy. 

The clone stamp can remove anything from wires, dust spots, unwanted hair, and even 

people. It does this by cloning pixels from another part of the photo. 

Let’s say I want to remove the man’s sandals in the photo from a beach in India. I’ll show 

you how to do that with the clone stamp tool.  
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Step 1: Open the photo and zoom in 

Open the photo you want to clean up and zoom in on the area you want to work with. Not 

too close, so you can still see what’s going on. 

Click on the clone stamp tool in the tool bar on the left. 

Always duplicate the background layer before you start working. This way, you can 

always go back to the original photo. Right click on the background layer and select 

‘Duplicate Layer. 

 

Step 2: Select a clone source 

Pick a soft brush. Set the size of the clone stamp so it will cover the object you want to 

remove. It takes some practice to know how hard and big your brush should be. 

A good setting to start is a medium soft brush to achieve smooth edges.  
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Move the cursor to the area you want to take pixels from. In this case I need sand. Use 

Alt-click to confirm your source pixels. The cursor will change into crosshairs. 

The moment you click, the cursor will change and show the pixels you’ve cloned.  

 

Step 3: Paint over the object you want to remove 

Now start painting over the object you want to remove. Make sure it’s not obvious that 

you are duplicating another part of the photo. 

If it’s noticeable, go back to clone other pixels and continue painting.  
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Repeat this until everything looks natural. If you want to go a few steps back in Photoshop, 

use undo. Cmd + Z in Mac OS or Ctrl + Z in Windows. 

What you have to look out for is patterns. Patterns will give away the fact that you’ve 

cloned pixels and removed an object.  

 
Avoid patterns to make the cloning look natural 

The clone source panel comes in handy when trying to avoid patterns. Use the two mirror buttons to make 

your cloning look more natural. 

This will mirror the pixels you paint over the unwanted object. The result will look better.  
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Playing around with the opacity of the brush will also help. Always try to mix different 

clone sources and opacity settings to get the best result. 

The edges of the clone stamp have to be as smooth as possible.  
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3. Tools calibration 

In Photoshop, calibration refers to the process of adjusting and fine-tuning the color and 

tonal accuracy of your monitor, printer, or other input/output devices to ensure consistent 

and accurate color reproduction. Calibration is crucial because different devices can 

display or print colors differently due to variations in their hardware and settings. 

Photoshop provides various tools and settings to help you calibrate your devices: 

Color Settings: Photoshop's Color Settings dialog box allows you to customize the color 

management settings for your workflow. It lets you specify the color space (such as sRGB, 

Adobe RGB, or ProPhoto RGB) and the rendering intent (perceptual, relative colorimetric, 

etc.) for consistent color reproduction. 

Monitor Calibration: To ensure accurate color representation on your monitor, you can 

use external hardware calibration devices, such as colorimeters or spectrophotometers. 

These devices measure the characteristics of your monitor and create an ICC profile that 

Photoshop and other color-managed applications can use to adjust the displayed colors. 

Soft Proofing: Soft proofing allows you to simulate how your images will look when 

printed on different devices or using specific profiles. The Soft Proof feature in Photoshop 

enables you to preview the color shifts that may occur when you convert an image from 

one color space to another or when printing with different profiles. 

Printing Calibration: When it comes to printing, you can use printer profiles specific to 

your printer and paper combination. These profiles describe how your printer reproduces 

colors and help ensure accurate color output. Photoshop lets you select and assign printer 

profiles to your images to achieve more predictable and consistent results. 

Adjustment Tools: Photoshop offers a wide range of adjustment tools that allow you to 

fine-tune colors, tones, and contrast in your images. These tools, such as Levels, Curves, 

and Hue/Saturation, can help you correct any color imbalances or discrepancies that may 

occur during the calibration process or due to other factors.  

4. Layers creation and preservation  

You can think of layers as transparent panes of glass stacked on top of one another, which 

allow different parts of each layer to show through. There are several types of layers you'll 

use in Photoshop, and they fall into two main categories: 

Content layers: These layers contain different types of content, like photographs, text, 

and shapes. 

Adjustment layers: These layers allow you to apply adjustments to the layers below them, 

like saturation or brightness. Adjustment layers are a type of nondestructive 

editing because they don't actually change anything about the original image. 

When using layers, it may be helpful to turn individual layers on and off to see how they 

affect the image. You can do this by clicking the eye icon next to each layer name. 
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Click the eye icons in the interactive below to practice turning different layers on and off. 

Notice how hiding content layers like the Background layer has a more noticeable effect 

than hiding adjustment layers like the Adjust Levels layer. 

At this point, you may be wondering why you even need to use layers. Wouldn't it just be 

easier to work with everything in your image at once? The truth is, layers give you an 

amazing amount of flexibility and control because you can edit each layer 

independently from the rest of the image. Once you become comfortable with layers, you'll 

use them all the time. 

Layer basics 

You can view, create, and edit layers with the Layers panel. This will generally be found 

in the lower-right corner of the screen, although you can always go to Window > Layers to 

make sure it's turned on. 

In Adobe Photoshop, a "layer" refers to a fundamental concept used for organizing and 

manipulating elements within an image or design. 

Layers in Photoshop allow you to work on different parts of an image independently, 

stacking them on top of each other to create complex compositions. Each layer acts as a 

transparent sheet that can contain various elements such as images, text, shapes, or 

adjustments. 

By utilizing layers, you can make edits to specific areas of an image without affecting the 

rest. This non-destructive editing approach provides flexibility and allows you to 

experiment with different effects and changes while preserving the original image. 

Layers can be manipulated individually, allowing you to adjust their position, size, 

opacity, blending modes, and more. You can move layers up or down in the layer stack to 

change their order, which affects how they interact with other layers. Layers can also be 

organized into groups, making it easier to manage complex designs with multiple 

elements. 

Furthermore, Photoshop offers several features to enhance your work with layers. Layer 

masks allow you to hide or reveal specific parts of a layer, enabling you to selectively 

apply edits or create seamless composite images. Layer styles enable you to add various 

effects, such as shadows, strokes, gradients, or overlays, to individual layers. 

Additionally, adjustment layers are a powerful tool in Photoshop. They allow you to apply 

non-destructive adjustments, such as brightness/contrast, levels, hue/saturation, and more, 

to specific layers or the entire image. 
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Creating an adjustment layer 

If you've never used layers, we recommend trying adjustment layers first. Remember, an 

adjustment layer does not contain content; it simply allows you to apply adjustments to 

the layers below it. 

In the Layers panel, select the layer below where you want the adjustment layer to appear. 

In our example, we'll select the Cake layer. 

 

Click the Adjustment button at the bottom of the Layers panel, then choose the desired 

adjustment.  
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The adjustment layer will appear, and you can then customize the adjustment in 

the Properties panel. Any changes you make will affect every layer below the adjustment 

layer. We'll talk more about using the Properties panel for different adjustments 

throughout the tutorial. 

 

 

You can also use the buttons in the Adjustments panel to create an adjustment layer. 
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In the example file, select the Cake layer, then create a Hue/Saturation adjustment layer. 

Try using the sliders in the Properties pane to see the effect. 

Creating a blank layer 

There may be times when you'll want to create a new blank layer. For example, if you 

want to draw on an image with the Brush tool, you could create a new layer and then draw 

on that layer. 

To create a new layer, click the New Layer button near the lower-right corner of 

the Layers panel. The new layer will appear in the Layers panel. 

 

Duplicating a layer 

There will also be times when you'll want to duplicate an existing layer. This is an easy 

way to try out different edits without altering the original layer. 
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Right-click the layer, then select Duplicate Layer. 

 

A dialog box will appear. Click OK. The duplicate layer will appear. 
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Deleting a layer 

If you find that you no longer need a layer, you can delete it. To do this, simply select the 

layer and press the Delete key on your keyboard. You can also click and drag the layer to 

the Trash Can in the lower-right corner of the Layers panel. 

 

There are many ways to work with the layers in your file. For example, you can show and 

hide different layers or change the stacking order. 

Showing and hiding layers 

To hide a layer, simply click the eye icon next to the desired layer. Click it again to show 

the layer. In the image below, you can see that we've turned off the Text layer, so the text 

is no longer visible in the document window: 
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Reordering layers 

The order in which layers are stacked will determine how the document looks. There may 

be times when you need to change the stacking order. To reorder a layer, simply click and 

drag the layer to the desired position in the Layers panel. In the image below, you can see 

that we've moved the Cake layer to the very top, which completely covers up the layers 

below it. 

 

If you want to reorder the Background layer of the image, you will need to right-click it 

and select Layer from Background. This will convert the background to a regular layer, 

which can be reordered. 

 

 

5. Image correction 

Image correction refers to the process of enhancing or modifying digital images to improve 

their overall quality, appearance, or accuracy. It involves various techniques and 

adjustments aimed at correcting issues such as exposure problems, color inaccuracies, 

noise reduction, and other imperfections present in the original image. 
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Here are some common types of image correction techniques: 

Exposure Adjustment: This technique involves modifying the brightness and contrast 

levels of an image to improve visibility and highlight details. It helps in correcting 

underexposed or overexposed areas. 

Color Correction: Color correction aims to adjust the color balance and tones of an image. 

It helps in eliminating color casts, enhancing saturation, and achieving a more natural and 

visually pleasing color representation. 

White Balance Correction: White balance correction is used to ensure accurate 

reproduction of colors by eliminating any color cast caused by different light sources. It 

involves adjusting the temperature and tint to make whites appear truly white. 

Sharpening: Sharpening techniques are applied to enhance the clarity and sharpness of an 

image, making the details more pronounced. It helps to counteract blurriness caused by 

factors like lens imperfections or camera shake. 

Noise Reduction: Noise refers to the random pixels or grainy texture that can appear in 

images, especially in low-light conditions or high ISO settings. Noise reduction techniques 

help in reducing or eliminating such unwanted noise while preserving image details. 

Cropping and Straightening: Cropping involves removing unwanted parts of an image to 

improve composition or focus on specific subjects. Straightening corrects the image's 

horizon or vertical alignment to make it appear more level and balanced. 

Lens Distortion Correction: Lens distortion occurs when lenses introduce unwanted 

effects like barrel distortion or vignetting. Correction techniques can rectify these issues 

to make the image appear more natural and undistorted. 

Retouching: Retouching involves removing or minimizing imperfections in the image, 

such as blemishes, spots, or unwanted objects. It can also include tasks like removing red-

eye, adjusting skin tones, or enhancing specific features. 

6. File format 

File format refers to the specific file extension used to save and store images created or 

edited within the software. Photoshop supports a wide range of file formats, each with its 

own characteristics, capabilities, and intended use. Here are some common file formats 

used in Photoshop: 

PSD (Photoshop Document): PSD is the native file format of Adobe Photoshop. It 

supports all Photoshop features and preserves layers, masks, adjustment layers, and other 

editable elements. PSD files are typically used for saving and editing projects in 

Photoshop, allowing users to preserve the full editing capabilities of their work. 

 



 

79 

 

JPEG (Joint Photographic Experts Group): JPEG is a widely used lossy compression 

format for storing photographic images. It is commonly used for sharing images on the 

web or printing. When saving an image as a JPEG in Photoshop, you can adjust the 

compression level to balance between file size and image quality. 

PNG (Portable Network Graphics): PNG is a lossless compression format that supports 

transparency. It is commonly used for images with sharp lines, text, or graphics that 

require a transparent background. PNG files are often used for web graphics and logos 

that need to be placed on different colored backgrounds. 

TIFF (Tagged Image File Format): TIFF is a versatile file format that supports lossless 

compression and can store high-quality images with layers, transparency, and other 

Photoshop features. TIFF files are commonly used for print production or when maximum 

image quality and flexibility are required. 

GIF (Graphics Interchange Format): GIF is a compressed file format that supports 

animation and transparency. It is commonly used for small animations, icons, and simple 

graphics on the web. GIFs have a limited color palette, making them more suitable for 

simple images with solid colors or low-resolution graphics. 

PDF (Portable Document Format): While not exclusive to Photoshop, PDF is a widely 

used file format for sharing and archiving documents. In Photoshop, you can save your 

work as a PDF, which allows for multiple pages, layers, and vector elements to be 

preserved. PDFs are commonly used for creating digital portfolios or sending artwork for 

professional printing. 
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Self Check 3.1  

Answer the following questions: 

1 What are the uses of healing bruch tool? 

 

 

 

 

 

2 What are the uses of Clone Stamp Tool? 

 

 

 

 

 

3 What is tool calibration? 

 

 

 

 

 

4 What is image correction? 

 

 

 

 

  

 

5 What is file format in photoshop? 
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Answer Sheet 3.1 

1. What are the uses of healing bruch tool? 

Answer: The Healing Brush Tool is a powerful image editing tool in Adobe 

Photoshop that allows you to remove imperfections, blemishes, or unwanted 

objects from an image seamlessly. It works by sampling pixels from a source 

area and blending them with the surrounding pixels, resulting in a smooth and 

natural-looking repair. 

 

2. What are the uses of Clone Stamp Tool? 

Answer: The Clone Stamp Tool is a versatile and commonly used tool in 

Adobe Photoshop that allows you to sample pixels from one area of an image 

and replicate them in another area. It essentially creates a clone or duplicate 

of the sampled pixels and applies them to a new location. The Clone Stamp 

Tool has several practical uses in image editing and retouching 

 

3. What is tool calibration? 

Answer: In Adobe Photoshop, tool calibration refers to the process of 

adjusting or fine-tuning the settings of certain tools to achieve accurate and 

desired results. It involves configuring the tool's behavior, sensitivity, or 

response to better suit your specific needs and preferences. 

 

4. What is image correction? 

Answer:  Image correction in Photoshop refers to the process of adjusting and enhancing 

various aspects of an image to improve its overall appearance, color accuracy, tonal 

balance, and visual impact. It involves making precise edits to correct common issues or 

imperfections that may affect the quality or aesthetics of the image. 

 

5. What is file format in photoshop? 

File format refers to the specific file extension used to save and store images 

created or edited within the software. Photoshop supports a wide range of file 

formats, each with its own characteristics, capabilities, and intended use 
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Activity Sheet 3-1:  

Task: Retouch Image 

Working Procedure: 

1. Follow OSH and Ergonomics requirement 

2. Run Computer and Open Adobe Photoshop. 

3.  Collect sample image. 

4. Perform image retouching. 

5. Use necessary tools for retouching. 

6. Save your work at PSD and JPEG file format. 

7. Close all application and Close computer. 
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Learning Outcome 4: Apply Color Correction  

 

Content:  

1 Color correction methods  

a. Brightness and Contrast 

b. Hue and Saturation 

c. Level 

d. Curve 

e. Selective colour 

f. Variations 

g. Photo Filter 

2 Image mode  

a. RGB 

b. CMYK 

c. Grey scale 

d. LAB Colour 

e. Index Colour 

3 Image enhancement comparison 

4 Final image transferring procedure  

Assessment Criteria:  

1. Color correction methods are identified 

2. Appropriate image mode is selected 

3. Color correction methods are used 

4. Image enhancement is compared with the original one 

5. Design is saved in appropriate file format 

6. Final image is transferred to recipient 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 

 

  

Methodologies  
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•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 4 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1. Identify color correction methods 

2. Select Appropriate image mode 

3. Use Color correction methods 

4. Compare Image enhancement with the original one 

5. Save Design in appropriate file format 

6. Transfer Final image to recipient 

1. Color correction methods 

Basic Color Correction Techniques Using Photoshop  

Our eyes are very similar and in a way, comparable to a camera. Our eyes are excellent 

when it comes to making an automatic white balance. But cameras are not as good as our 

eyes in doing this. Below are five color correction techniques using Photoshop CC.  

1. Add the Threshold Adjustment and Curves for color correction 

When creating a new layer, go to Edit and Fill then select the layer with 50% gray. The 

layer blend mode must be set to Difference. It is important to set the Threshold level to 10 

and grab the Eyedropper tool while holding down the Shift button. You need to click to 

drop the color over the black spots.What follows next is to delete Threshold and add 

Curves Adjustment Layer. While zooming in the eyedropper to the area of interest, click 

once to have a color balance.  

2. Skin Color adjustment 

To set skin color to perfect, you will be shown with the skin color breakdown of White, 

Black, Latin, and Asian while balancing a fair amount of magenta, yellow, black and cyan 

for a perfect skin. The real technique in this tool is to choose a great area from which 

colors are adjusted and measured. 

3. Adjust the White Balance tool in Camera RAW editor 

In using this tool, you need to open the image in the Camera RAW editor to change the 

image to a smart object and go to Filter then Camera Raw Filter. While choosing the White 

Balance tool the neutral point in the photo to automatically make the white balance 

corrected.  

4. Adjustment for Hue and Saturation Layer 

This is the fourth method of color correction with the use of Photoshop CC. It basically 

needs a /hue and Saturation adjustment layer. You need to utilize the channel drop down 

to point any color that is overwhelmingly seen in the photo. Shifting the hue to reduce the 

saturation will make a big difference. But there is a limitation in using this tool. This 
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method works amazingly when there is a color that is obviously affecting uniformity of 

the whole image.  

5. Free Hand adjustment 

Using the ‘finger’ icon, this will take a Curves adjustment layer while the channels can be 

Red, Green and Blue. You have to drag either up and down on any part of the photo to 

introduce Red/Cyan, Green/Magenta or Blue/Yellow whenever there is a need to do so. In 

a photo whose orientation is landscape, this technique is really effective.  

 Adjusting color hue, saturation, and brightness 

Based on the human perception of color, the HSB model describes three fundamental 

characteristics of color: 

Hue 

Color reflected from or transmitted through an object. It is measured as a location on the 

standard color wheel, expressed as a degree between 0° and 360°. In common use, hue is 

identified by the name of the color, such as red, orange, or green.  

Saturation 

Strength or purity of the color (sometimes called chroma). Saturation represents the 

amount of gray in proportion to the hue, measured as a percentage from 0% (gray) to 100% 

(fully saturated). On the standard color wheel, saturation increases from the center to the 

edge. 

Brightness 

Relative lightness or darkness of the color, usually measured as a percentage from 0% 

(black) to 100% (white).  

  

HSB color model 

H. Hue 

S. Saturation 

B. Brightness 

 

 

Color modes 

• RGB Color mode  

• CMYK Color mode  

• Lab Color mode  

• Grayscale mode  

• Bitmap mode  

• Duotone mode  

• Indexed Color mode  
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RGB Color mode 

Photoshop RGB Color mode uses the RGB model, assigning an intensity value to each 

pixel. In 8 bits-per-channel images, the intensity values range from 0 (black) to 255 (white) 

for each of the RGB (red, green, blue) components in a color image.  

CMYK Color mode 

In the CMYK mode, each pixel is assigned a percentage value for each of the process inks. 

Although CMYK is a standard color model, the exact range of colors represented can vary, 

depending on the press and printing conditions.  

Lab Color mode 

Lab is based on the human perception of color. The numeric values in Lab describe all the 

colors that a person with normal vision sees. Because Lab describes how a color looks 

rather than how much of a particular colorant is needed for a device (such as a monitor, 

desktop printer, or digital camera) to produce colors. 

Grayscale mode 

Grayscale mode uses different shades of gray in an image. In 8-bit images, there can be up 

to 256 shades of gray. Grayscale values can also be measured as percentages of black ink 

coverage (0% is equal to white, 100% to black).  

Bitmap mode 

Bitmap mode uses one of two color values (black or white) to represent the pixels in an 

image. Images in Bitmap mode are called bitmapped 1-bit images because they have a bit 

depth of 1. 

Duotone mode 

Duotone mode creates monotone, duotone (two-color), tritone (three-color), and quadtone 

(four-color) grayscale images using one to four custom inks. 

Indexed Color mode 

Indexed Color mode produces 8 bit image files with up to 256 colors. When converting to 

indexed color, Photoshop builds a color lookup table (CLUT), which stores and indexes 

the colors in the image.  

 

Indexed color files can be saved in Photoshop, BMP, DICOM (Digital Imaging and 

Communications in Medicine), GIF, Photoshop EPS, Large Document Format (PSB), 

PCX, Photoshop PDF, Photoshop Raw, Photoshop 2.0, PICT, PNG,  

About channels  

Channels are grayscale images that store different types of information: 

The Channels panel lists all channels in the image—composite channel first (for RGB, 

CMYK, and Lab images). A thumbnail of the channel’s contents appears to the left of the 

channel name; the thumbnail is automatically updated as you edit the channel. 
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Channel types  

A.  Color channels 

B.  Spot channels 

C. Alpha channels 

 

Color information channels are created 

automatically when you open a new image. The 

image’s color mode determines the number of 

color channels created. For example, an RGB 

image has a channel for each color (red, green, 

and blue) plus a composite channel used for 

editing the image. 

 

Alpha channels store selections as grayscale 

images. You can add alpha channels to create 

and store masks, which let you manipulate or 

protect parts of an image. Spot color channels 

specify additional plates for printing with spot 

color inks. 

 

 

Method#1. Choosing A Gray Color for Color Correction: 

This method works by determining the perfect gray color for an image. To fix an image’s 

color, we must first determine which parts of the image should have been gray in real life. 

Then we’ll have to save that color as a Photoshop reference. 

If there isn’t any place in your photo that should have been gray in real life, we’ll have to 

designate the nearest area to gray. Following the discovery of that area, Photoshop will alter 

the other colors depending on a gray color guideline. 

Step-1: Open The Image In Photoshop. 

To open a file you wish to work on, go to File from the top menu and select Open. 
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Step-2: Select A Gray Reference: 

Next, we’ll select a gray pointer. Add a ‘New’ layer by pressing on the ‘Plus’ sign in the layer 

panel. 

  

 To make the layered gray, hit ‘Shift+Backspace’ on your keypad. A box will appear on the 

screen. On the ‘Contents Menu’, pick 50% Gray and press OK. 

  

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Open-The-Image-In-Photosho.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Select-A-Gray-Reference.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/To-make-the-layered-gray-hit-ShiftBackspace-on-your-keypad.-A-box-will-appear-on-the-screen.-On-the-Contents-Menu-pick-50-Gray-and-press-OK.jpg
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Now, choose ‘difference’ from the Blending Mode drop-down menu. 

  

 

Step-3: Locate The Darkest Spot: 

Select ‘Threshold’ from the ‘Adjustment’ Layer menu (right next to the Layer mask icon). 

There will be a diagram. 

  

 

Right now, determine which section is the darkest by moving the slider. 

  

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Now-choose-difference-from-the-Blending-Mode-drop-down-menu.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Locate-The-Darkest-Spot.jpg


 

91 

 

 

 Step-4: Eliminate The Layers: 

Delete all the remaining layers except for the primary layer. Select ‘Delete Layer’ from the 

context menu when you right-click on the Layer. 

  

 

Step-5: Curves: Choose Curves from the ‘Adjustment’ Layer. 

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Right-now-determine-which-section-is-the-darkest-by-moving-the-slider.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Eliminate-The-Layers.jpg
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 There are three Eye-droppers directly next to the curve, as you can see. Now choose the Gray 

point with the middle-eyedropper. 

  

 

Step-6: Select The Darkest Spot You Discovered Previously. 

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Curves-Choose-Curves-from-the-Adjustment-Layer.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/There-are-three-Eye-droppers-directly-next-to-the-curve-as-you-can-see.-Now-choose-the-Gray-point-with-the-middle-eyedropper.jpg
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 It will fix the image’s color. Remember that, even though we’re focusing on the darkest part 

of the image, it could not work for all of them. In that case, experiment with some other aspects 

of the image. It’s determined by how you wish to view the image. So, try to achieve the desired 

color. 

Step 7: Save Your Work: 

To save the photograph, go to File and Save As. 

  

  

  

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Select-The-Darkest-Spot-You-Discovered-Previously.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Save-Your-Work.jpg
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Here is the final output with your desired color. 

  

Method#2. Color Correction Using Color Balance: 

There is another approach to correct color. That’s how the Color Balance feature works. To 

do so, you’ll need a rudimentary understanding of color. As a result, we’ll use complementary 

colors in this project. 

If an image has a specific color cast (an excessive amount of one color), we’ll need to adjust 

the amount of the contrasting color. Look at the complementing colors first. 

Cyan – Red 

Magenta – Green 

Yellow – Blue 

 Assume the image has a red cast. It has an enormous amount of red in it. As you know, the 

cyan color is the polar opposite of red. As a result, we’ll boost the cyan, which will reduce the 

red. 

Let’s have a look at the procedure! 

 Step-1: Open The Photo File. 

To open the file you wish to work on, go to ‘File’ from the top menu and select ‘Open. 

  

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Here-is-the-final-output-with-your-desired-color.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Open-The-Photo-File.jpg
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Step-2: Make A Duplicate Layer. 

Duplicate the Background Layer by right-clicking it and selecting Duplicate Layer—

alternatively, press Ctrl+J on your keyboard. 

  

  

Step-3: Achieve Color Harmony. 

Select Color Balance from the Adjustment Layer menu (right next to the Layer mask icon). 

  

 Step-4: Balancing The Slider. 

Look at the photo below. 

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Make-A-Duplicate-Layer.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Achieve-Color-Harmony.jpg
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 It’s obvious that it’s cast in magenta. As a result, adjust the slider to make the green color 

brighter. When you’re through, come to a halt. 

  

 Now, there appears to be a yellow tint. As a result, we’ll also enhance the blue color. 

  

https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Balancing-The-Slider.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Its-obvious-that-its-cast-in-magenta.-As-a-result-adjust-the-slider-to-make-the-green-color-brighter.-When-youre-through-come-to-a-halt.jpg
https://www.adeptclippingpath.com/blogx/wp-content/uploads/2022/04/Now-there-appears-to-be-a-yellow-tint.-As-a-result-well-also-enhance-the-blue-color..jpg
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 Step-5: Modify the Image’s Light. 

You can use Curves to change the image’s illumination. 

  

  

Step-6: Make A Backup. 

To save the picture, go to File and Save As. 

  

Layers  

Photoshop layers are like sheets of stacked acetate. You can see through transparent areas of 

a layer to the layers below. You move a layer to position the content on the layer, like sliding 

a sheet of acetate in a stack. You can also change the opacity of a layer to make content 

partially transparent. 
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• Layer Selection & Creating layer 

• Grouping, and linking layers 

• Moving, stacking, and locking 

layers 

• Delete & Hide layers 

• Setting opacity and blending 

• Layer effects and styles 

• Adjustment and fill layers 

• Layer comps 

• Masking layers 

 

 

4. Image transferring procedure 

Import an Image into Photoshop 

You can import an image to Photoshop from both a computer and other device as camera, 

scanner or you will nedd to download form internet. 

1. Open Photoshop on your PC It’s in the All-Apps area of the Start menu in Windows. 

Use this method if you want to import a single image into your Photoshop project. 

2. To create a new file, press Ctrl+N(Windows) name the file, then click OK. 

 

 
 

3. Click the New Layer icon. It’s near the bottom-right corner of the Layers panel. It 

looks like a square sheet of paper with an upturned corner. This creates a new layer. 
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4. Click the File menu. It’s at the top-left corner of the screen. 

5. Click Place It’s near the center of the menu. This opens your computer’s file browser. 

 
 

6. Select the image you want to import and click Place. 
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7. Click the checkmark. It’s at the top of the screen. The image is now placed on the 

new layer. 
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Self Check 4.1 

 

Answer the following questions: 

1. What is hue and saturation? 

 

 

2. What is color correction? 

 

 

 

3. What is CMYK? 
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Answer Sheet 4.1 

1. What is hue and saturation? 

Hue refers to the pure color itself, often represented as a specific point on the color wheel. 

It determines the basic color family or category, such as red, blue, green, yellow, etc. Hue 

is essentially what we perceive as the "color" of an object or light source. The color wheel 

is a circular representation of hues, with the primary colors (red, blue, and yellow) evenly 

spaced around the wheel, and the secondary and tertiary colors in between. 

Saturation, on the other hand, refers to the intensity or purity of a color. It represents how 

vivid or dull a color appears. A highly saturated color is vibrant, rich, and intense, while 

a desaturated color is more muted, pale, or washed out. Saturation is often represented as 

a percentage, with 100% indicating full saturation and 0% indicating a completely 

desaturated or grayscale color. 

2. What is color correction? 

Answer: color correction refers to the process of adjusting and enhancing the colors of an 

image to achieve a desired look or to correct any color issues. Photoshop provides various 

tools and techniques to perform color correction, allowing you to modify the hue, 

saturation, brightness, contrast, and other color attributes of an image. 

3. What is CMYK? 

Answer: CMYK is an acronym that stands for Cyan, Magenta, Yellow, and Key 

(Black). It is a color model used primarily in printing and is often referred to as a 

subtractive color model. CMYK is based on the concept that when these four ink colors 

are combined at varying levels, they can produce a wide range of colors.   
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Learning Outcome 5: Apply Effects  

Content:  

1 Effect options 

2 Image mode  

3 Effects comparison and adjustment 

4 Image transferring procedure 

Assessment Criteria:  

1 Identify appropriate effect options 

2 Proper image mode is selected 

3 Effects are applied to images/ layer as per requirements 

4 Effects are compared and adjusted 

5 Image is saved in appropriate file format 

6 Image is transferred to recipient 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 

Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 5 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1 Identify appropriate effect options 

2 Proper image mode is selected 

3 Effects are applied to images/ layer as per requirements 

4 Effects are compared and adjusted 

5 Image is saved in appropriate file format 

6 Image is transferred to recipient 

The Effect 

In Adobe Photoshop, the Effect options refer to a variety of visual enhancements and 

modifications that can be applied to an image or graphic element. These options allow you to 

manipulate and transform the appearance of your artwork in creative ways. Here are some of 

the commonly used Effect options in Photoshop: 

  

Drop Shadow: Adds a shadow behind an object to create a sense of depth or realism. You can 

control parameters like opacity, distance, angle, and size of the shadow. 

Inner Shadow: Similar to drop shadow, but the shadow is applied inside the boundaries of the 

object, creating a recessed or engraved effect. 

Outer Glow: Creates a soft halo of light around the edges of an object. You can adjust the 

glow's color, size, and opacity. 

Inner Glow: Similar to outer glow, but the light effect is applied inside the boundaries of the 

object. 

Bevel and Emboss: Adds a three-dimensional effect to an object by simulating highlights and 

shadows on its edges. You can control the depth, size, angle, and shading style. 

Satin: Applies a silky or metallic texture to an object, giving it a soft sheen. You can adjust 

parameters such as color, size, and blending mode. 

Gradient Overlay: Overlays a gradient fill on an object, allowing you to blend multiple colors 

smoothly across its surface. 

Pattern Overlay: Applies a pattern fill to an object, allowing you to use custom patterns or 

textures. 
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Stroke: Adds an outline or border around the edges of an object. You can specify the color, 

size, and position of the stroke. 

Drop Shadow: Applies a realistic shadow behind an object, simulating its interaction with 

light sources. You can control the shadow's opacity, angle, distance, and size.  

Image Mode 

In Photoshop, "image mode" refers to the color space or color model in which an image is 

represented. It determines the range and number of colors that can be used in an image. 

Photoshop provides several different image modes, each suited for specific purposes. The 

most common image modes in Photoshop are: 

RGB (Red, Green, Blue): This is the default mode for most images used on screens and in 

digital media. RGB mode uses combinations of red, green, and blue light to create a wide 

range of colors. Each pixel in the image is composed of three color channels (red, green, and 

blue) that can vary in intensity from 0 to 255. The combination of these channels determines 

the overall color of each pixel. 

CMYK (Cyan, Magenta, Yellow, Black): CMYK mode is primarily used for print purposes. 

It is a subtractive color model, where colors are created by subtracting varying amounts of 

cyan, magenta, yellow, and black inks. Unlike RGB, which uses light, CMYK represents 

colors using ink on paper. When working in CMYK mode, it's important to note that some 

colors visible on a computer screen might not be achievable in print. 
 

Grayscale: Grayscale mode represents images using shades of gray, ranging from black to 

white. It's commonly used for black and white photography or when color is not necessary. In 

grayscale mode, each pixel is represented by a single channel of varying intensity from 0 

(black) to 255 (white). 
 

Lab Color: Lab Color mode is a color model designed to encompass the full range of human 

vision. It separates the lightness (L) component from the color information (a and b axes), 

allowing for more accurate color adjustments and conversions. Lab Color mode is often used 

for advanced color correction and editing tasks. 
[ 

Indexed Color: Indexed Color mode uses a limited palette of colors to reduce the file size of 

an image. It assigns an index value to each color in the palette and stores the image data based 

on those indices. This mode is commonly used for web graphics or images with a limited 

number of colors, such as logos or icons.  
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Effect in Photoshop 

Step 1 – Preparing your Image  

First, you need to open your image on Photoshop and duplicate your layer.  

 
Use the Lasso tool on your background layer to cover your subject.  

 
Right-click within the lasso outline and click on Fill. 

Choose ‘content-aware’ and click OK. 
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Now you should be left with just the image background. 

 
Step 2 – Selecting your Subject 

Now you can use the Quick Selection tool to mark out a rough outline of your subject. This 

can be done in many ways, but the Quick Selection tool works well for this technique.  
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With your subject is selected, click ‘select + mask’ at the top. 

Now, you want the Refine Edge brush toward the left of your screen.  

 
Select ‘show edge’ to the right of your screen and draw a simple line around the outskirts of 

your subject. This will help with loose hairs and other more challenging-to-define edges in 

your image.  
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Then select ‘layer mask’ from the Output drop-down menu and press OK. 

 
 

Now duplicate the layer. Drag your layer to the bottom of the Layers panel and drop it onto 

the ‘new layer’ icon. 

 

 
Step 3 – Preparing the Dispersion Effect 
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Select the top image. Then, right-click on the new layer mask and select ‘apply layer mask’.  

 
The top layer should now be the isolated subject. Rename this layer ‘Dispersion’. This will 

make identifying your layers a lot easier.  Make a copy of your ‘Dispersion’ layer. You can  

 

now rename this to ‘Foreground’.  With the ‘Dispersion’ layer selected, go to Filter in the top 

bar, then select ‘liquify‘.  This will bring up a new window. Toward the top left of this 

window, there’s a Forward Warp tool. Select this tool, and now you will be able to drag out  

the area you want to disperse.   In this section, you can increase or decrease the size and 

strength of the Liquify brush. You want to warp the image to mimic the way ashes would fly 
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away from your subject. Be sure to use swooping motions to reflect 

this.  

Once you are happy, click OK. You will then see an image similar to this.  

 
Step 4 – Create the Dispersion Effect 

Now you need to get your layers ready for the dispersion effect. Click on your ‘Dispersion’ 

layer, and add a layer mask. For the ‘Dispersion’ layer, you want to Alt click (or Option click 

for Mac) when selecting the ‘Add Layer Mask’ icon in the lower layers panel. This 

automatically hides everything on your ‘Dispersion’ layer.  

 
Now create a layer mask for your ‘Foreground’ layer without the alt-click. This should leave 

your workspace looking like this.  
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Make sure your new Dispersion Effect Brush tool is in Photoshop.  

With these new brushes, start working away at the edges that go in the direction of the effect. 

Remember you are working on the new layer mask. You want to be painting with black 

selected.  

 
With these brushes, you can change the size and direction they face. Be sure to have your 

opacity and flow at 100%. When you have finished this, click on the mask for your 

‘Dispersion’ layer. We will now start adding the ‘ashes’. Invert your Brush tool color from 

black to white by clicking ‘x’. Now you can start revealing the bits you dragged out. Play 

around with this bit by changing brush sizes. You might also want to add a brush with the 

opacity reduced to fine-tune your effect.  
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Make sure you constantly switch between the ‘Dispersion’ and ‘Foreground’ layers to make 

the transition look refined. Remember that each time you swap masks, you need to be cautious 

of your brush color.  

Once you are happy with the dispersion effect you’ve created, you can further refine the 

image.  

Select the ‘Foreground’ image and use a brush to remove the bits that don’t fit. You want to 

use a white brush tool for this part. Here, I have left her face and shoulder intact. This makes 

it look like the model is just starting to disappear.  

 
You are now able to make any further edits, like sharpening or anything else you want! This 

is the most basic way to make a dispersion effect in Photoshop. 
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Saving options 

When saving a file in Photoshop, you have several options and file formats to choose from: 

PSD: This is the default file type for Photoshop documents, although you won't necessarily 

use it for every image. It will save your layers and all of the other information in your image 

so you can easily re-edit it later. PSD files are designed to be opened in Photoshop, so if you 

want to share the image with others you'll also need to save a copy of the image in a common 

file format, like JPEG. 

Common file formats: You can save images in a variety of common file types, 

including JPEG and PNG. These file formats can be viewed and edited on almost any 

computer or mobile device, which makes them well-suited for sharing with others. However, 

unlike PSD files these formats aren't as useful if you plan to continue editing the file, and they 

also can't preserve layer information. 

Save for Web: If you're planning to upload an image to the Web, like on a blog or website, 

you'll want to use the Save for Web feature. This tool allows you to save images that 

are optimized for the Web, which will make them easier to download and view online. Save 

for Web also includes several helpful features for preparing images for the Web, including the 

option to resize images. 

In the image below, you can see three different versions of an image file: the original JPEG 

file, an edited PSD version, and a final JPEG version that's been resized and saved for the 

Web. You can see that the Web version has a much smaller file size than the original and PSD 

versions. 
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Ultimately, the saving option you choose will depend on what you need to do with the image. 

Let's take a look at a couple of scenarios to see why you might choose different saving options. 

Scenario 1 

Let's say you're asked to create a new header image for a company website. You've been given 

a photo to include, and you need to add some text with the company name. Because you'll 

likely edit and revise this type of project, you'll want to save it as a PSD file. This way, you 

can easily continue editing the file later on. And because it will eventually be posted online, 

you'll also want to use Save for Web to create a new JPEG version of the finished image. 

Scenario 2 

Let’s say you're planning to share some photos from a recent vacation with your friends. You'd 

just like to make some quick adjustments in Photoshop, like cropping and rotating, before 

sharing them. In this case, you could open the original image files in Photoshop, make the 

necessary adjustments, then save a new version of the edited photos as JPEGs. Because none 

of these edits are too complicated, you probably don’t need to save a separate PSD version of 

each image. 

As you can see, the saving option you choose will vary from project to project. Before saving 

an image, take a moment to consider the type of files you'll need. As you start to gain more 

experience with Photoshop, this process will begin to feel quick and natural. 

Using Save As 

You'll use the Save As command to save files in the PSD format, as well as other common 

formats like JPEG and PNG. 

With the image open in Photoshop, select File > Save As. 

 

 

A dialog box will appear. Type the desired file name, then choose a location for the file. You'll 

want to use a new file name to avoid accidentally overwriting the original file. 
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Click the Format menu, then choose the desired file format. In our example, we'll save this 

image as a JPEG file. If you're saving as a PSD file, make sure the Layers option is checked. 

However, most other formats won't allow you to select this option. Click Save.  

 

Some file formats, such as JPEG and TIFF, will give you additional options when saving. 

Select the desired quality level, then click OK to save the image. 
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If you've already saved your project as a PSD file, you can select File >Save or 

press Ctrl+S (or Command+S on a Mac) to save your progress at any time. However, if you're 

working with another format like JPEG, we recommend using Save As to avoid overwriting 

your original file. 

Save for Web  

Go to File>Export>Save for Web (Legacy)... 

A dialogue box will appear. Select JPEG and lower your quality down to 60%. Make sure you 

have the checkbox for “Progressive” checked. (Progressive means that when you first get to 

your web page, it will show a low quality version of the full picture that will progressively 

gets sharper as the page loads. Otherwise, the picture will load in full quality, but only a bar 

of information at a time.) 

Check to make sure your photo size is around 100K or less before you save it. If it is too big, 

you might need to lower the quality down to 50%. 
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Click save. Choose where you want to save the image and then click save again. 
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Self Check 5.1  

Answer the following questions: 

1 What is effect in photoshop? 

 

 

 

2 Why we use drop shado? 

 

 

 

3 What is Bevel and Emboss? 

 

 

 

4 Write some image mode. 
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Answer Sheet 5.1 

1. What is effect in photoshop? 

Answer: Effect options refer to a variety of visual enhancements and 

modifications that can be applied to an image or graphic element. These 

options allow you to manipulate and transform the appearance of your 

artwork in creative ways 

2. Why we use drop shado? 

Answer: Adds a shadow behind an object to create a sense of depth or realism. You 

can control parameters like opacity, distance, angle, and size of the shadow. 

3. What is Bevel and Emboss? 

Answer:  Adds a three-dimensional effect to an object by simulating highlights and 

shadows on its edges. You can control the depth, size, angle, and shading style. 

4. Write some image mode. 

Answer: 

•  RGB (Red, Green, Blue) 

• CMYK (Cyan, Magenta, Yellow, Black):  

• Grayscale 

• Lab Color:  

• Indexed Color 
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Activity Sheet 5-1:  

Task: Apply effect in a jpeg image. 

Working Procedure: 

1. Follow OSH and Ergonomics requirement 

2. Run Computer and Open Adobe Photoshop. 

3.  Collect sample image 

4. Apply effect as per the sample image. 

5. Save your work at PSD and JPEG file format 
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Learning Outcome 6: Evaluate own work 

Content:  

1 Constructive criticism 

2 Own works evaluation  

Assessment Criteria:  

1 Constructive criticism from others is applied to improve own works. 

2 Own works are evaluated against planned Strategy for own practice. 

Resources Required/ Conditions: 

 The trainees must be provided with the following: 

• Training resources 

- References 

- Audio/video materials 

- Modules 

- Target stakeholdres 

- Competency standard 

• Training facilities / area 

- Computer and peripherals 

- Multimedia projector 

 

Methodologies  

 

•  Lecture/discussion  

• Demonstration/application  

• Presentation 

• Self-pace instruction 

• Blended delivery methods  

  

Assessment Methods 

  

• Written test   

• Demonstration  

• Observation with checklist  

• Oral questioning  

• Portfolio  
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Information Sheet 6 

Learning Objectives:  

After completion of this information sheet, the learners will be able to: 

1 Apply constructive criticism from others to improve own works. 

2 Evaluate own works against planned Strategy for own practice 

Constructive criticism 

Constructive criticism is a feedback approach that focuses on providing helpful and valuable 

insights to improve someone's work, skills, or behavior. It involves offering thoughtful and 

specific suggestions for improvement while maintaining a respectful and supportive tone. The 

purpose of constructive criticism is to assist the person receiving feedback in recognizing areas 

of weakness or opportunities for growth and providing guidance on how to address them 

effectively. 

Key elements of constructive criticism include: 

Specificity: Constructive criticism should be specific and focused on particular aspects of the 

work or behavior being evaluated. Vague or general comments may not provide enough 

guidance for improvement. Instead, pinpoint specific areas that require attention or suggest 

alternative approaches. 

Clarity: It is important to clearly communicate the feedback, ensuring that the person receiving 

it understands the issues being addressed. Use clear and concise language to avoid confusion 

or misinterpretation. 

Balance: Constructive criticism should strike a balance between pointing out areas for 

improvement and acknowledging the strengths and positive aspects of the work. By 

highlighting both the positives and negatives, the person receiving feedback can gain a more 

well-rounded understanding of their performance. 

Respect and Empathy: Constructive criticism should be delivered in a respectful and 

empathetic manner. Recognize the effort and intentions behind the work and acknowledge the 

person's skills and capabilities. It is crucial to provide feedback that motivates and inspires 

rather than demoralizes or discourages. 

Solution-Oriented: Constructive criticism should not only identify problems but also offer 

potential solutions or suggestions for improvement. Providing actionable recommendations 

helps the person receiving feedback understand how to address the identified issues and make 

progress. 

Open Dialogue: Encourage a two-way conversation by inviting the person to share their 

perspective, ask questions, and provide their insights. This fosters a collaborative and 

constructive environment, allowing for a deeper understanding of the feedback and fostering 

a sense of ownership over the improvement process. 
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Timing and Relevance: Consider the timing and context in which you provide constructive 

criticism. Choose an appropriate moment where the person is receptive and open to feedback. 

Also, ensure that the feedback is relevant and aligned with the goals or objectives of the work 

or project. 

Evaluation 

Evaluation refers to the systematic process of assessing and determining the value, worth, 

effectiveness, or quality of something. It involves gathering information, analyzing data, and 

making judgments or conclusions about the object or subject being evaluated. Evaluation is 

conducted to understand the strengths, weaknesses, impacts, and outcomes of a program, 

project, product, process, or any other entity. It helps in making informed decisions, improving 

performance, and informing future actions. 

Evaluating your own work in graphic design is an essential part of the creative process. It 

helps you identify strengths and weaknesses, make improvements, and grow as a designer. 

Here are some steps to effectively evaluate your own work in graphic design: 

Define the objectives: Start by clarifying the objectives of the project. Understand what you 

were trying to achieve and the intended message or purpose of the design. This will provide a 

clear framework for evaluation. 

Take a break: After completing a project, take some time away from it. Step back and give 

yourself a fresh perspective. This break will help you detach emotionally and view your work 

more objectively. 

Review the brief: Revisit the initial project brief or requirements. Compare your final design 

with the original goals and see if you have effectively met them. Evaluate whether the design 

meets the needs of the target audience and aligns with the desired message. 

Consider the context: Think about the context in which your design will be used. Consider the 

medium, platform, or environment in which it will be presented. Evaluate how well your 

design fits within that context and if it effectively communicates its intended message. 

Assess the visual elements: Analyze the visual aspects of your design, including layout, 

composition, color palette, typography, and imagery. Evaluate if they work harmoniously 

together, convey the desired mood or tone, and create visual impact. Consider principles of 

design, such as balance, contrast, hierarchy, and unity. 

Seek feedback: One of the most valuable ways to evaluate your work is to seek feedback from 

others. Reach out to fellow designers, mentors, or clients to get their perspective. Ask for 

constructive criticism and specific suggestions for improvement. Be open to different 

viewpoints and learn from the insights of others. 

Test with the target audience: If possible, conduct user testing or gather feedback from the 

target audience. This can provide valuable insights into how well your design communicates 

and resonates with the intended users. Consider conducting surveys, focus groups, or usability 

tests to gather feedback directly. 
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Compare with industry standards: Evaluate your work in comparison to industry standards 

and current design trends. Stay updated with the latest design practices, techniques, and styles. 

Assess if your design is innovative, unique, and competitive within the field. 

Reflect on your process: Evaluate not only the final outcome but also your design process. 

Assess if you effectively managed your time, resources, and workflow. Reflect on the 

decisions you made, the challenges you faced, and the lessons learned along the way. 

Iterate and improve: Based on your evaluation, identify areas of improvement and create an 

action plan. Implement the necessary changes, refine your design, and iterate as needed. 

Remember that evaluation is an ongoing process, and each project provides an opportunity for 

growth and learning.  

When evaluating your own work in graphic design, it can be helpful to have a structured 

approach. Here's a technique you can follow to assess and improve your designs: 

1. Initial Assessment: 

• Take a step back and look at your design with fresh eyes. 

• Note your initial thoughts and feelings about the design. 

• Consider the project's objectives and whether you believe you've met them. 

2. Analyze the Design Elements: 

• Evaluate the visual elements of your design, such as layout, color, typography, 

imagery, and composition. 

• Assess how well these elements work together to convey the intended message or 

evoke the desired emotions. 

• Consider the principles of design (e.g., balance, contrast, hierarchy, unity) and 

determine if they have been effectively applied. 

3. Assess the User Experience: 

• Put yourself in the shoes of the target audience. 

• Evaluate how the design communicates and engages with the users. 

• Consider the clarity of the message, ease of navigation, and overall user-

friendliness. 

• Identify any potential usability issues or areas for improvement. 

4. Evaluate the Impact: 

• Reflect on the design's effectiveness in achieving its purpose. 

• Consider whether it grabs attention, communicates the intended message clearly, 

and elicits the desired response. 

• Assess its visual impact and whether it stands out within its intended context. 

5. Seek Feedback: 

• Share your work with others, such as fellow designers, mentors, or clients. 

• Request specific feedback and constructive criticism on various aspects of your 

design. 

• Consider their perspectives and insights, and use them to gain a broader 

understanding of the strengths and weaknesses of your work. 
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• Compare with Competitors and Industry Standards: 

• Research and analyze the work of other designers or competitors in the field. 

• Compare your design to industry standards and current design trends. 

• Assess whether your design stands out, is competitive, and pushes boundaries in a 

positive way. 

6. Iterate and Improve: 

• Based on your evaluation and feedback received, identify areas for improvement. 

• Prioritize the changes or adjustments that will have the most significant impact. 

• Make necessary revisions and refinements to enhance your design. 

7. Document and Learn: 

• Keep a record of your evaluation process, including the feedback received and the 

improvements made. 

• Reflect on what you've learned from the evaluation and how it can inform your 

future work. 

• Continuously seek opportunities to develop and grow as a designer. 
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Self Check 6.1  

Answer the following questions: 

 

1. What is Constructive criticism? 

 

 

 

 

2. What are key elements of constructive criticism? 

 

 

 

 

3. What is Evaluation? 
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Answer Sheet 6.1 

1. What is Constructive criticism? 

Answer: Constructive criticism is a feedback approach that focuses on 

providing helpful and valuable insights to improve someone's work, skills, or 

behavior. It involves offering thoughtful and specific suggestions for 

improvement while maintaining a respectful and supportive tone. 

2. What are key elements of constructive criticism? 

Answer: Key elements of constructive criticism include: 

• Specificity 

• Clarity 

• Balance 

• Respect and Empathy 

• Solution-Oriented 

• Open Dialogue 

• Timing and Relevance 

3. What is Evaluation? 

Answer: Evaluation refers to the systematic process of assessing and determining the value, 

worth, effectiveness, or quality of something. It involves gathering information, analyzing 

data, and making judgments or conclusions about the object or subject being evaluated.   
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Review of Competency 

Below is yourself assessment rating for module “Developing Competency Based Training Curriculum” 

Sl no Assessment of performance Criteria  Yes No 

1.  Image is selected   

2.  Required tool is selected   

3.  Clipping path is created   

4.  Image is separated from background   

5.  New document is created   

6.  Images are pasted for edit   

7.  Layers are created and selected.   

8.  Images are edited and arranged.   

9.  Appropriate retouch tools are identified   

10.  Tools are calibrated as required   

11.  Layers are created and preserved   

12.  Retouch tools are used as per requirement   

13.  Images are corrected and saved in appropriate file format   

14.  Color correction methods are identified   

15.  Appropriate image mode is selected   

16.  Color correction methods are used   

17.  Image enhancement is compared with the original one   

18.  Design is saved in appropriate file format   

19.  Final image is transferred to recipient   

20.  Identify appropriate effect options   

21.  Proper image mode is selected   

22.  Effects are applied to images/ layer as per requirements   

23.  Effects are compared and adjusted   

24.  Image is saved in appropriate file format   

25.  Image is transferred to recipient   

26.  Constructive criticism from others is applied to improve own works.   

27.  Own works are evaluated against planned Strategy for own practice.   

I now feel ready to undertake my formal competency assessment. 

Signed: 

Date: 
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Development of CBLM: 

 

The Competency Based Learning Material (CBLM) of ‘Separate and compose images’ 

(Occupation: Graphic Design, Level-3) for National Skills Certificate is developed by NSDA 

with the assistance of SIMEC System, ECF consultancy & SIMEC Institute JV (Joint Venture 

Firm) in the month of June 2023 under the contract number of package SD-9A dated 07th May 

2023. 
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